[image: image1.png]The Meeting Transcript of
The Los Angeles County
Board of Supervisors




[image: image2.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors




May 16, 2006


[image: image3.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors





          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 

            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to

       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There is no reportable action as a result of the

Board of Supervisors' closed session held today.]

SUP. YAROSLAVSKY: MEETING OF THE BOARD OF SUPERVISORS IS NOW IN SESSION. IF I CAN CALL THE MEETING TO ORDER. ASK EVERYBODY TO STAND FOR THE INVOCATION AND THE PLEDGE OF ALLEGIANCE. OUR INVOCATION IS GOING TO BE LED BY PASTOR LOUIS V. PETIT-FRERE OF THE EPHESUS SEVENTH DAY ADVENTIST CHURCH IN LOS ANGELES IN THE SECOND SUPERVISORIAL DISTRICT, AND OUR PLEDGE OF ALLEGIANCE WILL BE LED BY OUR OWN COLONEL JOSEPH SMITH. PASTOR? 

PASTOR LOUIS V. PETIT-FRERE: LET US BOW OUR HEADS. FATHER GOD, WE THANK YOU FOR THIS OPPORTUNITY TO BE HERE. WE ASK THAT YOUR SPIRIT WOULD PRESIDE OVER THIS MEETING AND THAT YOU WOULD GUIDE THE DISCUSSIONS AND THE DECISIONS THAT WILL BE MADE, THAT IT WILL BE TO THE BEST -- FOR THE BEST OF ALL THAT ARE HERE, AND WE ASK FOR WISDOM AND UNDERSTANDING. WE ASK THESE THINGS IN YOUR MIGHTY NAME. AMEN. 

COLONEL JOSEPH SMITH: PLEASE PLACE YOUR RIGHT HAND OVER YOUR HEART, AND JOIN ME (AUDIO INTERFERENCE) IN THE PLEDGE OF ALLEGIANCE. [ PLEDGE OF ALLEGIANCE ] 

SUP. YAROSLAVSKY: SUPERVISOR BURKE. 

SUP. BURKE: YES. WE'RE VERY PLEASED TO HAVE PASTOR LOUIS V. PETIT-FRERE, WHO OBTAINED HIS BACHELOR'S DEGREE IN ARTS AND RELIGION FROM ANDREWS UNIVERSITY AND HIS MASTER'S OF DIVINITY DEGREE FROM THE SEVENTH DAY ADVENTIST THEOLOGY SEMINAR, BOTH LOCATED IN BEARING SPRINGS, MISSOURI. PASTOR PETIT-FRERE RECEIVED HIS OFFICIAL CALL INTO FULL-TIME MINISTRY FROM THE SOUTHERN CALIFORNIA CONFERENCE OF SEVENTH DAY ADVENTIST IN DECEMBER 2003. HE IS SENIOR PASTOR AT THE EPHESUS CHURCH OF SEVENTH DAY ADVENTISTS IN LOS ANGELES. THIS CHURCH HAS BEEN SERVING SOUTH LOS ANGELES COMMUNITY FOR OVER 20 YEARS WITH AN AFTER-SCHOOL TUTORING PROGRAM, HOT MEALS FOR THE HOMELESS AND FOOD DISTRIBUTION. WE ARE VERY PLEASED TO HAVE YOU HERE. THANK YOU VERY MUCH FOR THAT INSPIRATIONAL PRAYER. [ APPLAUSE ] 

SUP. BURKE: THANK YOU VERY MUCH. 

SUP. YAROSLAVSKY: THANK YOU, SUPERVISOR BURKE. NEXT IS THE AGENDA, AND BEFORE WE GO TO THE PRESENTATIONS, WE'LL CALL THE AGENDA. 

CLERK SACHI HAMAI: GOOD MORNING, MR. CHAIRMAN, MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 6 WITH THE SET MATTER ON ITEM S-1. THE CHIEF ADMINISTRATIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TO JULY 18TH, 2006, AT 11:30 A.M. 

SUP. YAROSLAVSKY: WITHOUT OBJECTION, THAT'LL BE THE ORDER. 

CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D AND 2-D. ON ITEM 1-D, HOLD FOR A MEMBER OF THE PUBLIC, ITEM 2-D IS BEFORE YOU. 

SUP. YAROSLAVSKY: ON ITEM 2-D MS. BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 12. 

SUP. YAROSLAVSKY: KNABE MOVES. BURKE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: ADMINISTRATIVE OFFICER, ITEMS 13 THROUGH 15. AND ITEMS 13 AND 14, THOSE ITEMS WILL NEED TO BE CARRIED OVER TO THE MAY 23RD, 2006 BOARD MEETING, SINCE THEY REQUIRE FOUR VOTES. ITEM 15 IS BEFORE YOU. 

SUP. YAROSLAVSKY: WITHOUT OBJECTION, ITEM 13 AND 14 WILL BE CONTINUED A WEEK. ITEM 15, BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: AFFIRMATIVE ACTION, ITEM 16. SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE HELD. 

SUP. YAROSLAVSKY: SO, OKAY. WE'LL HOLD IT. 

CLERK SACHI HAMAI: AGRICULTURAL COMMISSIONER/ WEIGHTS AND MEASURES, ITEMS 17 THROUGH 19. 

SUP. YAROSLAVSKY: KNABE MOVES. BURKE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: CHIEF INFORMATION OFFICE, ITEM 20. 

SUP. YAROSLAVSKY: BURKE MOVES. KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: CHILD SUPPORT SERVICES, ITEM 21. 

SUP. YAROSLAVSKY: BURKE MOVES. KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: DISTRICT ATTORNEY, ITEM 22. 

SUP. YAROSLAVSKY: KNABE MOVES. I'LL SECOND IT. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: FIRE DEPARTMENT, ITEM 23. 

SUP. YAROSLAVSKY: BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: HEALTH SERVICES, ITEMS 24 THROUGH 28, AND ON ITEM 25, THE DIRECTOR OF HEALTH SERVICES REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO MAY 30TH, 2006. THE REST ARE BEFORE YOU. 

SUP. YAROSLAVSKY: ITEM 25 WILL BE CONTINUED TWO WEEKS. THE REST OF THE ITEMS, KNABE MOVES, BURKE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: HUMAN RESOURCES, ITEM 29. 

SUP. YAROSLAVSKY: ITEM 29? 

CLERK SACHI HAMAI: YES. 

SUP. YAROSLAVSKY: BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: INTERNAL SERVICES, ITEMS 30 THROUGH 32. 

SUP. YAROSLAVSKY: KNABE MOVES, BURKE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: MENTAL HEALTH, ITEM 33. 

SUP. YAROSLAVSKY: BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: PARKS AND RECREATION, ITEM 34. SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE HELD. 

SUP. YAROSLAVSKY: ALL RIGHT. IT'LL BE HELD. NEXT ITEM. 

CLERK SACHI HAMAI: PROBATION, ITEM 35. 

SUP. YAROSLAVSKY: BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: PUBLIC LIBRARY, ITEMS 36 AND 37, AND ON ITEM 36, AS NOTED ON THE GREEN SUPPLEMENTAL SHEET, SUPERVISOR ANTONOVICH REQUESTS THAT HIS RECOMMENDATION BE REFERRED BACK TO THE OFFICE. BOTH ITEMS ARE BEFORE YOU. 

SUP. YAROSLAVSKY: BOTH ITEMS, BEING 36 AND 37? 

CLERK SACHI HAMAI: CORRECT. 

SUP. YAROSLAVSKY: 36 WILL BE REFERRED BACK TO MR. ANTONOVICH'S OFFICE. 

CLERK SACHI HAMAI: MR. CHAIRMAN, MEMBERS OF THE BOARD, JUST HIS RECOMMENDATION. THE ITEM IS ACTUALLY BEFORE YOU. 

SUP. YAROSLAVSKY: I SEE, MR. ANTONOVICH'S RECOMMENDATION WILL BE REFERRED BACK TO HIS OFFICE, AND THAT WAY -- 

SUP. KNABE: WE'RE STILL MOVING ON THE REST OF IT, THE ORIGINAL ITEM? 

SUP. YAROSLAVSKY: THE ORIGINAL ITEMS AS ORIGINALLY PRESENTED WILL BE BEFORE US. 

CLERK SACHI HAMAI: CORRECT. 

SUP. YAROSLAVSKY: 36 AND 37, BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: PUBLIC SOCIAL SERVICES, ITEMS 38 AND 39. ON BOTH ITEMS, 38 AND 39, AS NOTED ON THE GREEN SUPPLEMENTAL SHEET, THE DIRECTOR OF PUBLIC SOCIAL SERVICES REQUESTS THAT THESE ITEMS BE CONTINUED ONE WEEK TO MAY 23RD, 2006. 

SUP. YAROSLAVSKY: WITHOUT OBJECTION, THAT'LL BE THE ORDER. 

CLERK SACHI HAMAI: PUBLIC WORKS, ITEMS 40 THROUGH 54. ON ITEM 40, HOLD FOR A MEMBER OF THE PUBLIC. ON ITEM 42, THE DIRECTOR OF PUBLIC WORKS REQUESTS THAT THIS ITEM BE REFERRED BACK TO HIS DEPARTMENT. THE REST ARE BEFORE YOU. 

SUP. YAROSLAVSKY: ON THE BALANCE, BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: MISCELLANEOUS COMMUNICATIONS, ITEMS 55 THROUGH 61. AND ON ITEM 57 AND 60, SUPERVISOR YAROSLAVSKY WOULD LIKE TO CONTINUE THESE ITEMS ONE WEEK TO MAY 23RD, 2006. THE REST ARE BEFORE YOU. 

SUP. KNABE: 57 AND WHAT? 

CLERK SACHI HAMAI: 60. 

SUP. YAROSLAVSKY: 60. WITHOUT OBJECTION, THOSE TWO ITEMS WILL BE CONTINUED. THE BALANCE OF THE ITEMS ARE BEFORE US. KNABE MOVES, BURKE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: ORDINANCE FOR ADOPTION, ITEMS 62 AND 63. ON ITEM 63, THE DIRECTOR OF HEALTH SERVICES WOULD LIKE TO CONTINUE THIS ITEM ONE WEEK TO MAY 23RD, 2006. THE REMAIN -- ITEM 62 IS BEFORE YOU. 

SUP. YAROSLAVSKY: OKAY. IS ITEM 62 A NEW, IS THIS JUST A FEE ORDINANCE. IS THAT WHAT THIS IS? 

SUP. KNABE: 62 IS JUST THE FEE. 

SUP. YAROSLAVSKY: OKAY. BURKE MOVES. I'LL SECOND. UNANIMOUS VOTE, ON 62, AND 63 WILL BE CONTINUED ONE WEEK. NEXT ITEM. 

CLERK SACHI HAMAI: SEPARATE MATTERS, ITEMS 64 AND 65. ON ITEM 64, THIS ITEM WILL NEED TO BE CARRIED OVER TO THE MAY 23RD, 2006 BOARD MEETING SINCE IT REQUIRES FOUR VOTES. 

SUP. YAROSLAVSKY: SO ORDERED. SO ORDERED. 

CLERK SACHI HAMAI: AND ON 65, I'LL JUST READ THIS INTO THE RECORD. THE TREASURER AND TAX COLLECTOR'S RECOMMENDATION IS TO APPROVE FISCAL YEAR 2006 AND '07, TAX AND REVENUE ANTICIPATION NOTES, SHORT-TERM TAX EXEMPT BORROWING PROGRAM AND ADOPT RESOLUTIONS PROVIDING FOR THE ISSUANCE AND SALE OF THE 2006/07 TAX AND REVENUE ANTICIPATION NOTES IN AN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $1 MILLION. -- $1 BILLION, $1 BILLION. EXCUSE ME. MISSED THOSE LAST THREE ZEROS. $1 BILLION. 

SUP. KNABE: A SMALL "B" OR A CAPITAL "B"? 

SUP. YAROSLAVSKY: YOU'LL LEARN, SACHI, THAT WE DON'T DEAL IN MILLIONS AT THIS BOARD [ LIGHT LAUGHTER ]. THIS IS THE BIG TIME HERE, THE BIG SHOW. [ LIGHT LAUGHTER ] 

SUP. YAROSLAVSKY: ALL RIGHT. WE HAVE THAT ITEM BEFORE US? 

CLERK SACHI HAMAI: YES. 

SUP. YAROSLAVSKY: KNABE MOVES, BURKE WILL SECOND. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: PUBLIC HEARING, ITEM 66. ON ITEM 66 SUPERVISOR ANTONOVICH REQUESTS THAT THIS ITEM BE CONTINUED WITHOUT DISCUSSION TO JUNE 7TH, 2006, AT 9:30 A.M. 

SUP. YAROSLAVSKY: ALL RIGHT. WITHOUT OBJECTION, THAT'LL BE THE ORDER, JUNE THE 7TH. 

CLERK SACHI HAMAI: MISCELLANEOUS, ITEM 67, ADDITIONS TO THE AGENDA REQUESTED BY BOARD MEMBERS AND THE CHIEF ADMINISTRATIVE OFFICER, WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING, AS INDICATED ON THE GREEN SUPPLEMENTAL AGENDA. ITEM 67-A. 

SUP. YAROSLAVSKY: HANG ON A SECOND HERE. KNABE MOVES. I'LL SECOND. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: 67-B. 

SUP. YAROSLAVSKY: KNABE MOVES. BURKE SECONDS, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: 67-C. 

SUP. YAROSLAVSKY: I'LL MOVE IT. BURKE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: 67-D. 

SUP. YAROSLAVSKY: I'LL MOVE IT, BURKE SECONDS, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: 67-E. 

SUP. YAROSLAVSKY: DIDN'T WE JUST DO THAT? 

CLERK SACHI HAMAI: E, I THINK WE JUST DID D, BUT 67-E? 

SUP. YAROSLAVSKY: OH THAT'S DIFFERENT THAN THE ITEM 66? 

SUP. KNABE: THAT'S SUNSHINE. 

SUP. YAROSLAVSKY: OH. THIS IS SUNSHINE. OKAY. KNABE MOVES. I'LL SECOND. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: 67-F. 

SUP. YAROSLAVSKY: THEY -- BURKE MOVES, KNABE SECONDS. UNANIMOUS VOTE. 

CLERK SACHI HAMAI: 67-G, AND ON 67-G, THIS IS AN ORDINANCE FOR INTRODUCTION AND I WILL READ THE SHORT TITLE FOR THE RECORD, AN ORDINANCE AMENDING A FRANCHISE TO OPERATE A CABLE TELEVISION SYSTEM TO PROVIDE CABLE TELEVISION SERVICE IN THE STEVENS [STEVENSON] RANCH UNINCORPORATED AREA GRANTED TO TIME WARNER ENTERTAINMENT COMPANY L.P., A DELAWARE LIMITED PARTNERSHIP TO ADD TERRITORY AND ELIMINATE REQUIREMENTS CONCERNING DISTRIBUTION OF FRANCHISE FEE PAYMENTS. 

SUP. YAROSLAVSKY: BURKE MOVES, KNABE SECONDS. WITHOUT OBJECTION, UNANIMOUS VOTE. 

CLERK SACHI HAMAI: THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS' SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NUMBER 4. 

SUP. YAROSLAVSKY: NUMBER 4. MR. KNABE. 

SUP. KNABE: YEAH I WILL PROCEED, BUT I SHOW THAT YOU HAVE AN EMPLOYEE OF THE MONTH PRESENTATION, I BELIEVE, PRIOR TO MY BEGINNING. 

SUP. YAROSLAVSKY: YOU ARE CORRECT. THANK YOU. ALL RIGHT. I'D LIKE TO ASK CARMEN GATICA, IS THAT THE CORRECT PRONUNCIATION? GATICA? COME ON UP HERE. OUR EMPLOYEE OF THE MONTH FOR THE MONTH OF MAY IS CARMEN GATICA SANDATE. CARMEN HAS BEEN WORKING FOR THE COUNTY OF LOS ANGELES FOR THREE YEARS AND IS CURRENTLY EMPLOYED AS A COMMUNITY WORKER WITH THE DEPARTMENT OF MENTAL HEALTH, WHERE SHE IS ASSIGNED TO THE EMERGENCY OUTREACH BUREAU PROVIDING EMERGENCY AND HOMELESS OUTREACH SERVICES TO INDIVIDUALS, FAMILIES -- INDIVIDUALS AND FAMILIES LIVING IN AND AROUND DOWNTOWN LOS ANGELES AND ALSO IN HOLLYWOOD. CARMEN IS FREQUENTLY SOUGHT OUT BY SENIOR STAFF BECAUSE OF HER POSITIVE ATTITUDE, EAGERNESS TO LEARN AND ACCEPT DIRECTION BUT, MOST IMPORTANTLY, HER SPANISH SPEAKING ABILITY, WHICH WAS UTILIZED EXTENSIVELY DURING THE METROLINK TRAIN DERAILMENT IN GLENDALE IN 2005 AND IN HER CAPACITY AS A CRISIS SCREENER. ALWAYS RESPECTFUL OF HER CLIENTS NO MATTER WHAT THEIR STATUS OR SITUATION, CARMEN IS WILLING TO MEET THEM ON THEIR OWN TURF, BE IT IN A RUNDOWN MOTEL ROOM, A PARK OR EVEN A TENT. SHE GIVES HER CLIENTS, WHO INCLUDE DISFRANCHISED MEN, WOMEN AND FAMILIES A CHANCE TO RECEIVE VITAL SERVICES. AS ONE TO PRACTICE GOOD CUSTOMER SERVICE, CARMEN IMMEDIATELY RESPONDS TO CRISES, IMMEDIATE SITUATIONS, OR PROTRACTED PUBLIC ENGAGEMENTS. HER NEED FOR SELF-IMPROVEMENT DRIVES HER TO ACHIEVE THE HIGHEST OF STANDARDS AS SHE SEEKS TO ALWAYS RAISE THE BAR IN HER EVERYDAY ACTIVITIES. WE WANTED TO -- AND IT'S FOR THOSE REASONS AND MANY OTHERS THAT SHE HAS BEEN SELECTED TO BE THE COUNTY OF LOS ANGELES EMPLOYEE OF THE MONTH FOR MAY OF 2006, AND THE BOARD OF SUPERVISORS OF LOS ANGELES COUNTY WANT TO PRESENT THIS PROCLAMATION TO YOU, CARMEN, AND HIGHLY COMMEND YOU FOR YOUR ACCOMPLISHMENTS, DEDICATION AND PUBLIC SERVICE AND CONGRATULATE YOU ON BEING NAMED THE EMPLOYEE OF THE MONTH, AND YOU MUST BE VERY SPECIAL IF ONLY AFTER -- AFTER ONLY THREE YEARS, THERE ARE PEOPLE WHO WORK HERE FOR 30 YEARS AND NEVER GET CONSIDERED FOR EMPLOYEE OF THE MONTH AND YOU'VE DONE IT IN THREE. NOW WHAT DO YOU DO FOR AN ENCORE? I DON'T KNOW. BUT THANKS FOR YOUR DEDICATION. YOU'RE DOING VERY IMPORTANT WORK, OBVIOUSLY IT'S AN ISSUE THAT'S ON ALL OF OUR MINDS AND ON ALL OF LOS ANGELES' MINDS AND WE WISH YOU CONTINUED SUCCESS. [ APPLAUSE ] 

SUP. YAROSLAVSKY: WE'VE GOT THE OFFICIAL EMPLOYEE OF THE MONTH PIN. DON'T LEAVE HOME WITHOUT IT. THERE YOU GO. DO YOU WANT TO SAY SOMETHING MARV, BEFORE -- OKAY, I'LL INTRODUCE MARV SOUTHARD, OUR DIRECTOR OF MENTAL HEALTH FOR THE COUNTY OF LOS ANGELES TO SAY A WORD AND THEN WE'LL TURN IT OVER TO CARMEN. 

MARVIN J. SOUTHARD: I JUST WANTED TO THANK YOU FOR THE WORK THAT YOU HAVE BEEN DOING AND TO HIGHLIGHT THE CRUCIAL NATURE OF THIS WORK. OFTENTIMES PEOPLE THINK THAT PERSONS WITH MENTAL ILLNESS WHO ARE DANGEROUS OUGHT TO BE PICKED UP AND TAKEN AWAY, AND IT'S PEOPLE LIKE CARMEN WHO ARE ABLE TO ENGAGE PEOPLE WHERE THEY ARE AND DRAW THEM INTO SERVICES THAT LEAD PEOPLE TO RECOVERY RATHER THAN A PUNITIVE APPROACH. SO CARMEN, I THINK YOU REPRESENT THE FUTURE OF THE FIELD OF MENTAL HEALTH, SO WE THANK YOU FOR YOUR PIONEERING WORK. [ APPLAUSE ] 

CARMEN GATICA SANDATE: WELL GOOD MORNING. IT'S AN HONOR TO BE HERE TODAY. I'D LIKE TO THANK MY FAMILY, MY CO-WORKERS FOR ALL THEIR SUPPORT, PATIENCE AND ENCOURAGEMENT FOR THIS, SO THANKS. [ APPLAUSE ] 

SUP. YAROSLAVSKY: ALL RIGHT. SUPERVISOR KNABE, YOU'RE UP. 

SUP. KNABE: THANK YOU, MR. YAROSLAVSKY, MEMBERS OF THE BOARD, LADIES AND GENTLEMEN, IT'S MY PRIVILEGE TO CALL UP MR. BOB CIESLA, WHO IS THE PROGRAM MANAGER, AND OF THE C-17 FOLLOW-UP PROGRAM AS WELL AS JACKI HARRIS, WHO SHE IS THE PRESIDENT OF U.A.W. LOCAL 148. THE C-17 GLOBEMASTER III FLEET REACHED THE MILLION-HOUR MILESTONE ON MARCH 19TH DURING AN AERIAL MEDICAL EVACUATION MISSION TRANSPORTING THE WOUNDED SOLDIERS FROM IRAQ TO THE LAND STALL REGIONAL MEDICAL CENTER IN GERMANY. THE C-17 FLEET REACHED THE MILESTONE OVER A YEAR AHEAD OF THE ORIGINAL OPERATIONAL PLANS AND THE C-17 HAS CONTINUALLY DEMONSTRATED DURING ITS FIRST ONE MILLION HOURS WHY IT IS NOW THE WORLD'S AIR LIFT OF CHOICE. THIS REMARKABLE ACCOMPLISHMENT OF A MILLION HOURS OF FLIGHTS IS A TESTAMENT TO ITS UNMATCHED ABILITY TO SUPPORT OUR TROOPS WHEREVER THEY ARE AND DELIVER HUMANITARIAN RELIEF WHEREVER NEEDED, ANY TIME, ANY PLACE. THE BOARD OF SUPERVISORS, THEN AND MYSELF AND MY -- ON BEHALF OF MYSELF AND MY COLLEAGUES AND THE CITIZENS OF THIS GREAT COUNTY WANT TO CONGRATULATE UNITED STATES AIR FORCE C-17 CREWS, ITS SUPPORT TEAMS, AS WELL AS THE MEN AND WOMEN WHO CROSS THE NATION WHO HELPED BUILD THE C-17 AND MAKE IT AN INVALUABLE ASSET TO THE CITIZENS OF LOS ANGELES COUNTY AND THE WORLD, AND I WOULD ADD TO BOB AND TO ALL THE OTHER MEMBERS OF THE BOEING TEAM THAT ARE WITH ME HERE TODAY, AS YOU MAY OR MAY NOT KNOW, THE C-17 IS PART OF OUR FEDERAL AGENDA AS WE CONTINUE TO WORK THE HALLS OF CONGRESS AND THE UNITED STATES SENATE TO NOT ONLY SHOW HOW IMPORTANT AND WHAT A GREAT AIRPLANE IT IS, BUT IT'S A MATTER OF NATIONAL SECURITY. AND SO WE'RE CONTINUING TO BE SHOULDER TO SHOULDER WITH YOU, SAYING WE WANT MORE C-17S, NOW IS NOT THE TIME TO CUT THE PRODUCTION, SO ANY MEMBER OF CONGRESS LISTENING TO THIS T.V. SHOW, YOU KNOW WE'RE COMING. ANYWAY, CONGRATULATIONS. [ APPLAUSE ] 

SUP. KNABE: SURE, ABSOLUTELY. 

BOB CIESLA: THANK YOU. ON BEHALF OF THE OVER 30,000 WORKERS IN FORTY-TWO STATES WHO DEPEND ON THE C-17 FOR THEIR LIVELIHOOD, INCLUDING 6,500 BOEING EMPLOYEES HERE IN LONG BEACH, THANK YOU VERY MUCH FOR THIS HONOR. I CAN'T THINK OF ANOTHER BOEING BUSINESS ANYWHERE IN THE NATION OR WORLD THAT ENJOYS THE CLOSE RELATIONSHIP WITH COMMUNITY THAT WE HAVE HERE IN SOUTHERN CALIFORNIA. WE APPRECIATE THE RESOLUTION OF SUPPORT YOU PASSED WHICH ENCOURAGED THE GOVERNMENT TO ORDER MORE C-17S, AND WE'RE ESPECIALLY GRATEFUL TO SUPERVISOR KNABE WHO USED THIS TIME WITH THE PRESIDENT TO PLEAD OUR CASE. WE DEEPLY APPRECIATE THIS STRONG SUPPORT, WHICH IS CRITICAL TO THE C-17 PROGRAM AND KEY TO BOEING'S FUTURE IN LONG BEACH. AND I WANT TO ASK OUR PARTNER, JACKI HARRIS, THE PRESIDENT OF GREAT UNION UAW LOCAL 148 TO SAY A FEW WORDS OF THANKS. 

JACKI L. HARRIS: THANK YOU, BOB. THANK YOU, SUPERVISOR KNABE AND CONNY AND ALL OF THE BOARD FOR HAVING US HERE TODAY AND FOR THIS HONOR. IT IS MY PLEASURE TO REPRESENT THE WORK FORCE THAT BUILDS THE C-17 AND BUILT THE FINAL 717 AND OTHER COMMERCIAL AIRCRAFT. WE'RE VERY PROUD OF THE PRODUCT AND OUR CUSTOMERS AND EVERYONE THAT HONORS US, AND WE JUST APPRECIATE THIS HONOR. THANK YOU VERY MUCH. [ APPLAUSE ] 

SUP. KNABE: NOW I'M GOING TO CALL UP THE CALIFORNIA STATE UNIVERSITY LONG BEACH CO-ED CHEERLEADING TEAM AND THEIR HEAD COACH, ERIC ANDERSON. FOR THE THIRD TIME IN FOUR YEARS, THE CO-ED CHEERLEADING TEAM AT THE CALIFORNIA STATE UNIVERSITY LONG BEACH, CAPTURED THE NATIONAL CHAMPIONSHIP IN ITS DIVISION AT THE UNITED SPIRIT ASSOCIATION'S COLLEGIATE CHEERLEADING AND DANCE NATIONALS IN LAS VEGAS, NEVADA. SO ON BEHALF OF MYSELF AND MY COLLEAGUES WE WANT TO CONGRATULATE YOU FOR THAT GREAT EFFORT, AND JUST TO REMIND EVERYONE, GO BEACH. HOW'S THAT, HUH? ALL RIGHT, CONGRATULATIONS. [ APPLAUSE ] 

SUP. KNABE: ALL RIGHT. 

ERIC ANDERSON: WELL UNFORTUNATELY THE WHOLE TEAM COULDN'T BE HERE TODAY BECAUSE WE HAVE FINALS THIS WEEK AND WE KNOW SCHOOL COMES FIRST, BUT WE HAVE A FEW PEOPLE UP HERE. I HAVE TWO OF MY CAPTAINS, KATHERINE AND SAMIA AND CRISTINA, WHO HAPPENS ALSO TO BE MY DAUGHTER. ACTUALLY, THIS IS THE FIFTH TIME WE HAVE WON THE NATIONAL TITLE AT LONG BEACH, AND I WANT TO THANK OUR ATHLETIC DEPARTMENT, OUR STUDENT BODY, AND I ALSO WANT TO THANK THE BOARD FOR RECOGNIZING US. AND THANK YOU FOR HAVING US HERE. 

SUP. KNABE: ALL RIGHT. CONGRATULATIONS. THANK YOU, ALL RIGHT. [ APPLAUSE ] 

SUP. KNABE: WITH THE SCHOOL YEAR WINDING DOWN, WE ALSO WANTED TO TAKE THE TIME TO HONOR TWO INCREDIBLE BASKETBALL TEAMS, I MIGHT ADD BOTH RESIDING IN THE FOURTH DISTRICT. BUT THE FIRST, WE HAVE THE LONG BEACH POLY GIRLS HIGH SCHOOL BASKETBALL TEAM AND THEIR COACH, KARL BUDS. THIS TEAM DEFEATED THE KNIGHTS IN 63-44 IN THE STATE SOUTHERN REGIONAL CHAMPIONSHIP GAME, THEN THEY ADVANCED TO THE STATE TITLE GAME WHERE THEY BEAT BERKELEY 53-TO-34 DURING THEIR FIRST TITLE IN THIS MODERN ERA, IS THE STATE CHAMPION. SO ON BEHALF OF MYSELF AND MY COLLEAGUES -- IS THAT TRUE? DID I SAY IT RIGHT? OH YOU JUST ARE SMILING FOR THE CAMERA, OKAY, ALL RIGHT. BUT ANYWAY, THERE'S A GREAT HISTORY, BOTH ACADEMIC AND ATHLETICALLY AT LONG BEACH POLY, AND YOU ALL HAVE CONTINUED THAT GREAT TRADITION AND CONGRATULATIONS ON NOT ONLY YOUR FIRST BUT I'M SURE IT'D BE MANY MORE OF THE STATE CHAMPIONS IN GIRLS' BASKETBALL, CONGRATULATIONS. [ APPLAUSE ] 

SUP. KNABE: YOU FOLKS WANT TO SAY SOMETHING? 

COACH KARL BUDS: FIRST, I'D LIKE TO THANK AND CONGRATULATE YOU ALL. WE HAVE A GREAT GROUP OF GIRLS, IT WAS A WONDERFUL OPPORTUNITY AND PLEASURE WORKING WITH THEM. WE WANT TO THANK ALL THE FOLKS WHO GAVE US UP TRAINING TO BE HERE TODAY, MR. KNABE AND THE WHOLE COMMUNITY, WE'RE JUST GLAD WE'RE ABLE TO REPRESENT THEM WELL. THANK YOU. 

SUP. KNABE: ALL RIGHT, OKAY WILL THE TEAM ALL GET, THERE WE GO, CAN YOU GET US ALL IN THERE? ALL RIGHT. [ INDISTINCT CONVERSATION ] 

SUP. KNABE: ALL RIGHT, ALL RIGHT, CONGRATULATIONS, POLY. CONGRATULATIONS. GREAT JOB. NEXT, IT'S MY PLEASURE TO BRING FORWARD THE 2006 STATE DIVISION III C.I.F. CHAMPIONS, THE ARTESIA HIGH SCHOOL BOYS VARSITY BASKETBALL TEAM AND THEIR COACHES SCOTT PARRA AND LAUREN GROVER, MIKE MENDEZ, KENDALL MORI MOTO, AND ERICK HOYA. SO THIS TEAM -- THAT'S WHAT HAPPENS WHEN YOU HAVE THE GIRLS CHAMPION AND THE BOYS CHAMPION THE SAME DAY, THEY'RE VISITING. BUT ANYWAY, THIS TEAM, THE ARTESIA HIGH SCHOOL TEAM HAD A RECORD OF 33-AND-1 FOR THE 2005/2006 SEASON. THE PIONEERS WON THE SUBURBAN LEAGUE CHAMPIONSHIP FOLLOWED BY THE SOUTHERN CALIFORNIA C.I.F. DIVISION III CHAMPIONSHIP AND THEN ONTO AND WINNING THE STATE C.I.F. CHAMPIONSHIP. THE TEAM IS RANKED NUMBER ONE IN CALIFORNIA BY CAL HIGH SPORTS, RANKED NUMBER TWO IN THE NATION BY SPORTS ILLUSTRATED, AND RANKED NUMBER FIVE IN THE NATION BY U.S.A. TODAY. ALSO COACH SCOTT PARRA AND JUNIOR FORWARD JAMES HARDIN WERE CHOSEN AS DREAM TEAM COACH AND PLAYER OF THE YEAR BY THE LONG BEACH PRESS TELEGRAM. SO ON BEHALF OF MYSELF AND MY COLLEAGUES IN THE BOARD AND ALL THE CITIZENS OF THIS GREAT COUNTY WE WANT TO SAY CONGRATULATIONS ONCE AGAIN ON A GREAT EFFORT AND A GREAT CHAMPIONSHIP AND I KNOW THAT SCOTT IS ANNOUNCED JUST RECENTLY THAT HE'LL BE LEAVING THE PROGRAM AS COACH BUT -- AND MOVING ON TO THE GREATER THINGS AS WELL, TOO, BUT WHAT A GREAT TEAM, AND THEY HAD SOME STRUGGLES EARLY ON, BUT THEY PULLED IT TOGETHER AND THEY ARE GREAT CHAMPIONS AND WE ARE REALLY PROUD OF ALL THEIR EFFORTS. AND THERE IS A THE SHORT GUY IN THE BACK THERE, TOO, AND HE WAS SORT OF TOUGH TO GET AROUND IN THE MIDDLE THERE. SO, ANYWAY, BIG HAND, ARTESIA HIGH SCHOOL, 2006 STATE C.I.F. CHAMPION. [ APPLAUSE ] 

SUP. KNABE: SCOTT? 

SCOTT PARRA: WE WOULD JUST LIKE TO SAY THANK YOU TO MR. KNABE AND EVERYONE HERE TODAY. WE'RE VERY HONORED TO REPRESENT ARTESIA HIGH SCHOOL. IT'S A GREAT GROUP OF YOUNG MEN AND WE'RE VERY PROUD OF WHAT WE ACCOMPLISHED ON THE FLOOR AND ON HOW WE HANDLE OURSELVES OFF THE FLOOR AS WELL, BUT AGAIN, THANK YOU VERY MUCH AND WE APPRECIATE EVERYTHING YOU'VE DONE. TAKE CARE. [ APPLAUSE ] 

SUP. KNABE: ALL RIGHT. 

SUP. YAROSLAVSKY: ALL RIGHT. CONGRATULATIONS TO BOTH TEAMS. NEXT, MS. BURKE, YOU HAVE SOME PRESENTATIONS? YOU DON'T HAVE ANY? THEN IT'S ME. WHO AM I CALLING UP? OKAY, I'D LIKE TO AND GRETCHEN LIGHTFOOT AND APRIL SPENCER TO COME FORWARD. IN HONOR OF A.L.S. AWARENESS MONTH, TODAY WE'RE PRESENTING THIS PROCLAMATION TO THE A.L.S. ASSOCIATED AND THEY'RE REPRESENTED HERE BY GRETCHEN LIGHTFOOT WHO'S THE DEVELOPMENT DIRECTOR FOR A.L.S. ASSOCIATION AND TO APRIL SPENCER, WHO'S ALSO AFFILIATED WITH THEM. A.L.S., COMMONLY KNOWN AS LOU GEHRIG'S DISEASE, IS A PROGRESSIVE DISORDER THAT OCCURS WHEN MOTOR NERVE CELLS IN THE CENTRAL NERVOUS SYSTEM STOP FUNCTIONING. A.L.S. STRIKES MORE THAN 5,000 NEW VICTIMS EACH YEAR IN THE UNITED STATES, AFFLICTING THEM WITH A DISEASE FOR WHICH THERE IS PRESENTLY NEITHER A KNOWN CAUSE NOR CURE. A.L.S. INITIALLY CAUSES WEAKNESS IN SKELETAL MUSCLES, PROGRESSES TO INCREASED DIFFICULTY SWALLOWING, TALKING AND BREATHING AND EVENTUALLY LEADS TO PROFOUND MUSCLE ATROPHY AND QUADRIPLEGIA, FULL QUADRIPLEGIA. IN ITS ADVANCED STAGE IT COULD COST AS MUCH AS $200,000 ANNUALLY PER PATIENT TO TREAT DEPLETING THE -- I'M SORRY, I'LL READ THIS WITH MY TRIFOCALS HERE, TO TREAT IT, THUS DEPLETING THE FINANCIAL RESOURCES OF PATIENTS AND RELATIVES ALIKE. IT IS IMPERATIVE THAT SOCIETY ACT TO HELP RELIEVE THE SUFFERING OF PATIENTS AND THE ANGUISH AND THE STRUGGLE OF THEIR CAREGIVERS AS MUCH AS POSSIBLE. AND, OF COURSE, IT'S IMPERATIVE THAT WE TRY TO GET OUR ARMS AROUND THIS DISEASE AND FIND A CURE. THE BOARD OF SUPERVISORS WANTED TO TAKE THIS OPPORTUNITY TO DECLARE MAY 2006 A.L.S. AWARENESS MONTH IN THE COUNTY OF LOS ANGELES AND ALL THE RESIDENTS OF THIS COUNTY ARE URGED TO BECOME EDUCATED AND TO LEND THEIR AID TO COMBATING THIS DISEASE. SO I WANTED TO PRESENT THIS TO GRETCHEN AND TO APRIL. COME UP, COME FORWARD HERE, WE'LL DO THIS AND I'LL ASK YOU TO SAY A COUPLE OF WORDS. 

GRETCHEN LIGHTFOOT: I'M GRETCHEN LIGHTFOOT AND I'M THE DIRECTOR OF DEVELOPMENT FOR THE A.L.S. ASSOCIATION GREATER LOS ANGELES CHAPTER, AND I BROUGHT WITH ME APRIL SPENCER TODAY. HER FATHER, KEN CONSTABLE, PASSED AWAY THREE YEARS AGO, OVER THREE YEARS AGO WITH A.L.S., AND I THINK IF YOU COULD HEAR A FEW WORDS FROM HER YOU'D UNDERSTAND HOW IMPORTANT IT IS TO INCREASE AWARENESS FOR THIS DISEASE. I WANT TO THANK YOU, FIRST OF ALL, FOR HAVING US HERE. IT'S A GREAT HONOR AND I ALSO WANT TO GIVE SUPERVISOR YAROSLAVSKY OUR A.L.S. WRIST BAND AND OUR PIN IN HONOR OF A.L.S. AWARENESS MONTH. THANK YOU. 

APRIL SPENCER: THANK YOU, I WANT TO ADD MY THANKS TO THE BOARD OF SUPERVISORS FOR THIS PROCLAMATION TO HELP US RAISE AWARENESS AROUND WHAT IS A TERRIBLE DISEASE. MY FATHER WAS A C.P.A. WITH HIS OWN PRACTICE IN SIMI VALLEY WHEN HE BEGAN NOTICING A SLUR IN HIS SPEECH IN 1999, IT WAS ALMOST A FULL YEAR BEFORE HE WAS DIAGNOSED WITH A.L.S. BECAUSE WITH A.L.S. YOU HAVE TO HAVE A DIAGNOSIS OF DEGENERATION IN MORE THAN ONE QUADRANT OF YOUR BODY, SO IT WASN'T UNTIL HE STARTED TO LOSE MUSCLE TONE IN HIS RIGHT SIDE OF HIS BODY THAT THEY ACTUALLY COULD DIAGNOSE HIM WITH A.L.S. WE WERE REFERRED TO THE U.C.L.A. MEDICAL CENTER WHERE HE RECEIVED WHAT I WOULD REFER TO AS DIAGNOSTIC CARE. HE WOULD COME IN AND BE TREATED FOR AND MEASURED FOR THE LOSS OF VOLUME IN HIS LUNG CAPACITY EVERY MONTH, BUT WE DIDN'T RECEIVE THE KIND OF CARE I THINK WE COULD HAVE GOTTEN WITH THE A.L.S. ASSOCIATION WHERE WE WOULD HAVE HAD A LITTLE MORE -- SOMEONE TO KIND OF HELP US ALONG THE WAY AS THE DEGENERATION TOOK PLACE AND HELP US WITH MY FATHER TO MAKE IT A LITTLE EASIER ON HIM AS HE HAD TO STRUGGLE WITH THE DAY-TO-DAY CARE OF JUST TRYING TO MAKE IT, TO MAKE IT GO. SO I THANK YOU FOR HELPING US RAISE AWARENESS AROUND THIS TERRIBLE RAVAGING DISEASE AND ALLOW US TO HELP IDENTIFY PATIENTS IN THE GREATER LOS ANGELES AREA AND HELP THEM COPE AND THEIR FAMILIES COPE AS THEY STRUGGLE WITH THIS, SO THANK YOU. 

SUP. YAROSLAVSKY: THANK YOU. THANK YOU VERY MUCH APRIL, AND GRETCHEN THANK YOU. [ APPLAUSE ] 

SUP. YAROSLAVSKY: NEXT, I WANT TO CALL DR. DAVID SANDERS AND MIRIAM KRINSKI FORWARD. AND HERE'S DAVID? WE'RE GOING TO BE HONORING OUR FOSTER CARE HEROES THIS MORNING AS WE'VE ALSO DECLARED THE MONTH OF MAY FOSTER CARE AWARENESS MONTH, AND WITHOUT FURTHER ADIEU, LET ME TURN IT OVER TO MIRIAM KRINSKI FIRST TO SAY A COUPLE OF WORDS AND THEN DAVID AND THEN WE'LL MAKE SOME PRESENTATIONS. 

MIRIAM KRINSKI: THANK YOU, SUPERVISOR YAROSLAVSKY, FOR YOUR SUPPORT WITH ALL THESE ISSUES. EVERY YEAR IN MAY, WE HAVE THE OPPORTUNITY TO REFLECT ON THE GOOD WORK THAT GOES ON IN OUR FOSTER CARE SYSTEM, ON THE TRUE HEROES WHO, THROUGH THEIR EFFORTS, THROUGH THEIR COMPASSION, THROUGH THEIR LOVE AND THROUGH THEIR RESILIENCE SHOW US THAT ALL OF US AS A COMMUNITY TRULY CAN MAKE A DIFFERENCE ON BEHALF OF THE NEARLY 25,000 CHILDREN IN OUR FOSTER CARE SYSTEM WHO ARE ABUSED AND NEGLECTED AND WHO ALL OF US UNDERTAKE TO PARENT WHEN THEY BRING THEM IN UNDER THE JURISDICTION OF OUR DEPENDENCY COURTS. THIS YEAR WE'VE PAID PARTICULAR ATTENTION TO THE VOICES OF THE CHILDREN IN OUR FOSTER CARE SYSTEM WHO, THROUGH A COMPILATION OF WORK, MY VOICE, MY LIFE, MY FUTURE, HAVE SHARED WITH US THEIR PERSPECTIVES ON WHAT LIFE IN FOSTER CARE IS ABOUT. ALICIA, AGED 17, WHO, WHEN SHE CAME INTO FOSTER CARE, WAS TOLD THAT SHE WOULD NEVER BE ABLE TO TALK, TO WALK, TO FUNCTION, IS TODAY A 17-YEAR-OLD YOUNG LADY WHO, LAST WEEK, PERFORMED AN INCREDIBLE DANCE IN WASHINGTON, D.C. AS OTHER FOSTER YOUTH AND ALICIA WERE HONORED FOR THEIR CREATIVE WORK. ALICIA WRITES IN A POEM IN OUR BOOKLET ENTITLED "I CAN'T BREATHE," "I CAN'T BREATHE, I CRY TEARS EVERY DAY BECAUSE CHILDREN ARE BEING BEATEN TO DEATH. CHILDREN HAVE NO HOME, AND I CAN'T BREATHE. I CRY BECAUSE CHILDREN NEED SOMEONE TO LOVE AND BE SAFE FROM, AND I CAN'T BREATHE. THIS IS ALL THE STUFF THAT TAKES MY BREATH AWAY AND STILL, I CAN'T BREATHE." ALL OF US AS A COMMUNITY HAVE THE OPPORTUNITY THIS MAY TO HELP ALICIA AND 500,000 OTHER CHILDREN LIKE HER WHO ARE PART OF OUR NATION'S FOSTER CARE SYSTEM. WE HONOR THE GOOD WORK ALL OF YOU OUR HEROES SO WELL EXEMPLIFY AS ALL OF US STRIVE TO STEP UP AND HELP CHILDREN NOT SIMPLY BE ABLE TO BREATHE, BUT BE ABLE TO HAVE A BETTER FUTURE. 

SUP. YAROSLAVSKY: THANK YOU VERY MUCH, MIRIAM. DAVID SANDERS, THE DIRECTOR OF OUR DEPARTMENT OF CHILDREN AND FAMILY SERVICES, FOR A COUPLE OF WORDS. 

DR. DAVID SANDERS: THANK YOU, SUPERVISOR YAROSLAVSKY AND THE BOARD OF SUPERVISORS FOR THE RECOGNITION OF THE FOSTER CARE HEROES, AND THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES IS RESPONSIBLE FOR OVER 20,000 CHILDREN IN FOSTER CARE, AND OVER THE LAST FEW YEARS, WE'VE SEEN IMPROVEMENT IN ALL OF THE AREAS THAT ARE IMPORTANT IN OVERSEEING THE SUPPORT OF KIDS, OVERSEEING KIDS. KIDS ARE SAFER TODAY THAN EVER BEFORE, KIDS ARE MORE STABLE IN CARE, KIDS SPEND LESS TIME IN CARE AND THERE ARE FEWER KIDS IN CARE, ALL OF WHICH ARE IMPORTANT MEASURES. BUT THE REASON FOR THAT SUCCESS IS BECAUSE THE PEOPLE WHO ARE BEING HONORED TODAY, THE FOSTER CARE HEROES, THE FOSTER PARENTS, THE FORMER FOSTER YOUTH, THE MEDICAL PROFESSIONALS, THE MENTAL HEALTH PROFESSIONALS, THE ATTORNEYS WHO ADVOCATE AND THE SOCIAL WORKERS, AND THE CRITICAL ROLE THAT THEY PLAY IN ASSURING THE SAFETY AND CARE FOR CHILDREN IN FOSTER CARE. SO I AM VERY PLEASED TO BE ABLE TO STAND BEFORE YOU AND HONOR THE WINNERS AS WELL AS TO THANK THE BOARD OF SUPERVISORS FOR THEIR ONGOING SUPPORT FOR KIDS IN CARE IN OUR SYSTEM. 

SUP. YAROSLAVSKY: THANK YOU, DAVID. AND JUST BRIEFLY TO ADD MY TWO CENTS WORTH, THE PURPOSE OF DECLARING THIS MONTH FOSTER CARE AWARENESS MONTH, IS NOT ONLY TO HONOR THESE GREAT HEROES THAT WE ARE HONORING TODAY, BUT ALSO TO BRING THE MESSAGE OF FOSTER CARE AND THE PLIGHT OF OUR KIDS AND WHAT THE GENERAL PUBLIC CAN DO ABOUT IT ONE KID AT A TIME, ONE FAMILY AT A TIME, AND WE HOPE THAT THROUGH THE BROADCAST OF THIS MEETING AND OTHER EFFORTS THAT ARE MADE TO DISSEMINATE THE INFORMATION ABOUT FOSTER CARE AWARENESS MONTH AND THE FOSTER CARE PROGRAM, THAT SOMEBODY WILL BE MOVED TO MAKE A CONNECTION WITH US AND TURN THE LIFE OF SOME CHILD AROUND, AND SOME CHILD MEANS ONE CHILD AND THAT MEANS A LOT. SO, DAVID, THANK YOU FOR THE GREAT WORK YOU'RE DOING. MIRIAM, THANK YOU FOR YOUR REALLY LIFELONG ADVOCACY ON THIS ISSUE AND WE'RE GOING TO GO DOWN AND MAKE A COUPLE OF PRESENTATIONS THERE AND THEN WE'RE GOING TO COME BACK AND MAKE THE REMAINDER OF THE PRESENTATIONS HERE. SO LET'S GO DOWN THERE. [ INDISTINCT CONVERSATION ] 

SUP. YAROSLAVSKY: ALL RIGHT. WE WANT TO PRESENT THE FIRST PROCLAMATIONS TO ERNESTO AND DONNA DELALTO, WHO ARE THE FOSTER PARENTS WHO ARE BEING HONORED TODAY. THE DELALTOS HAVE ADOPTED FOUR MEDICALLY FRAGILE FOSTER CHILDREN. ONE OF THEIR ADOPTED DAUGHTERS CANNOT SEE, HEAR, SPEAK OR SWALLOW BECAUSE OF THE ABUSE SHE SUFFERED. IN ADDITION TO PROVIDING 24-HOUR CARE TO HER CHILDREN, MRS. DELALTO IS STUDYING TO BECOME A NURSE. WE HAVE A JOB FOR YOU ONCE YOU FINISH, BELIEVE ME. THEY ARE AN INSPIRING AND A REMARKABLE FAMILY AND WE WANTED TO TAKE THIS OPPORTUNITY TO PRESENT YOU WITH THIS PROCLAMATION. I WANT TO JUST MENTION THE CHILDREN, BEAUTIFUL NAMES. THE GIRLS THAT THEY HAVE WITH THEM TODAY ARE HEAVEN. HEAVEN, SAY HI. JUST WAVE. OKAY. SERENITY, THERE'S SERENITY. MIRACLE. HEY, MIRACLE. AND JOSIE. AND THERE'S JOSIE. SO, YOU PICKED SOME GOOD NAMES. SO WE WANT TO PRESENT YOU WITH THIS PROCLAMATION, SIGNED BY ALL FIVE OF US, AND THANK YOU FOR YOUR COMMITMENT BEYOND ANYBODY'S IMAGINATION, BEYOND THE CALL OF DUTY. THANK YOU, THANK YOU VERY MUCH, NOW -- [ APPLAUSE ] 

SUP. YAROSLAVSKY: ALL RIGHT, THANK YOU. IT'S AN HONOR TO MEET YOU. WHERE DO YOU GUYS LIVE? 

SPEAKER: IN LANCASTER. 

SUP. YAROSLAVSKY: LANCASTER, YEAH WE SAID HELLO. HI. HOW ARE YOU? EMILY HOW ARE YOU? TONY. OKAY. I ALSO WANTED TO POINT OUT THE DELALTOS DROVE ALL THE WAY DOWN HERE FROM LANCASTER THIS MORNING, AND THAT'S A SACRIFICE IN AND OF ITSELF. SO, WE BETTER START, GO BACK HERE. ALL RIGHT. NEXT, I WANT TO PRESENT THE -- A PROCLAMATION TO THE SOCIAL WORKER HERO THAT WE'RE HONORING, CLAUDIA BUSTIOS, CLAUDIA IS A KINSHIP SUPERVISING SOCIAL WORKER, WHO'S DEDICATED TO SUPPORTING RELATIVE CAREGIVERS AND THE CHILDREN THEY CARE FOR. SHE HAS A POSITIVE ATTITUDE WHICH DIRECTLY AFFECTS THE SOCIAL WORKERS SHE SUPERVISES, AS WELL AS THE RELATIVE CAREGIVERS IN HER SUPPORT GROUPS. MS. BUSTIOS BECAME A SOCIAL WORKER SO THAT SHE COULD HAVE AN IMPACT ON PEOPLE'S LIVES, AND SHE CLEARLY IS DOING THAT FOR OUR FOSTER CHILDREN HERE IN LOS ANGELES COUNTY. SO CLAUDIA? THERE YOU ARE. NEXT IS DR. ASHFORD HAGAR, WHO IS OUR PEDIATRICIAN HONOREE. DR. HAGAR CREATED THE COUNTY'S FIRST ONE STOP HEALTH CENTER FOR ABUSED AND NEGLECTED CHILDREN WHICH UTILIZES MULTI-DISCIPLINARY INTERVENTIONS INCLUDING FORENSICS EXAMS, MENTAL HEALTH SERVICES AND COMPREHENSIVE FAMILY SERVICES. HER CENTER IS A MODEL THAT THE COUNTY IS WORKING TO REPLICATE, SHE CURRENTLY IS BUILDING A COALITION OF MULTI-DISCIPLINARY PROVIDERS TO SERVE FOSTER CHILDREN WITH DEVELOPMENTAL DELAYS RESULTING FROM PRENATAL EXPOSURE TO ALCOHOL. AND ASHFORD IS NOT A STRANGER TO THE BOARD, AND WE WANT TO THANK YOU AND HONOR YOU THIS MORNING FOR YOUR LIFELONG PROFESSIONAL WORK IN THIS FIELD. THANKS. [ APPLAUSE ] 

SUP. YAROSLAVSKY: THANKS ASHFORD. NEXT IS CHRISTOPHER MALLORY, A FORMER FOSTER YOUTH. CHRISTOPHER ENTERED FOSTER CARE AT THE AGE OF NINE AND EMANCIPATED WHEN HE WAS 18. DESPITE MANY SCHOOL TRANSFERS, HE GRADUATED HIGH SCHOOL WITH HONORS AND RECEIVED A STUDENT OF THE YEAR AWARD. HE CURRENTLY HELPS OTHER FOSTER YOUTH BY SERVING AS A PEER COUNSELOR FOR THE EMANCIPATION PREPARATION PROGRAM AT LONG BEACH CITY COLLEGE. NOT ONLY IS HE SELF-SUFFICIENT, WHICH IS AN IMPRESSIVE FEAT FOR SUCH A YOUNG MAN, HE ALSO ASSISTS HIS OLDER SISTER AND IS ACTIVELY INVOLVED IN THE UPBRINGING OF HIS NIECE AND NEPHEW. CHRISTOPHER MALLORY. [ APPLAUSE ] 

SUP. YAROSLAVSKY: NEXT IS MARGERY SHELBY, ATTORNEY FOR THE LEGAL AID FOUNDATION OF LOS ANGELES. MARGERY HAS ATTAINED NATIONAL RECOGNITION FOR HER EXPERTISE IN THE AREA OF FOSTER CARE BENEFITS. SHE ADVOCATES TIRELESSLY AND PASSIONATELY ON BEHALF OF CHILDREN AND FAMILIES IN THE FOSTER CARE SYSTEM. SHE HAS DEDICATED HER CAREER TO ADDRESSING THE NEEDS OF THE MOST VULNERABLE CHILDREN IN OUR SOCIETY. MARGERY SHELBY. [ APPLAUSE ] 

SUP. YAROSLAVSKY: OKAY. REPRESENTING JEANETTE YOFFI IS STEPHANIE SCHNEIDER. STEPHANIE? THERE YOU ARE, HOW YOU DOING? OKAY. WE'RE GOING TO PRESENT THIS TO YOU FOR JEANETTE. JEANETTE YOFFI IS THE THERAPIST WE'RE HONORING TODAY, AND I GUESS SHE'S EXPECTING ANY MINUTE, SO THAT'S WHY -- 

STEPHANIE SCHNEIDER: SHE HAD HER BABY YESTERDAY. 

SUP. YAROSLAVSKY: SHE HAD HER BABY YESTERDAY? 

STEPHANIE SCHNEIDER: A LITTLE BOY. 

SUP. YAROSLAVSKY: A LITTLE BOY, AND I GUESS THAT'S A GOOD EXCUSE, FOR NOT PICKING UP HER PROCLAMATION. ALL RIGHT, JEANETTE ENTERED FOSTER CARE IN NEW YORK WHEN SHE WAS AN INFANT AND WAS ADOPTED BY A LOVING FAMILY AT THE AGE OF SEVEN. IN COLLEGE, SHE WROTE AN AWARD WINNING ONE WOMAN SHOW, "WHAT'S YOUR NAME, WHO'S YOUR DADDY," WHICH DEPICTS HER PERSONAL JOURNEY THROUGH FOSTER CARE AND ADOPTION. JEANETTE YOFFI EARNED A MASTER'S DEGREE IN CLINICAL PSYCHOLOGY AND NOW WORKS WITH CHILDREN AND FAMILIES IN THE FOSTER CARE SYSTEM AND THE ADOPTION PROCESS. HER PASSIONATE DEDICATION TO THIS CAREER AND HER PERSONAL EXPERIENCE INSPIRES CHILDREN AND FAMILIES THAT SHE SERVES. SO THIS IS, STEPHANIE, GIVE TO HER. ALL RIGHT. GREAT, THANKS. AND LAST BUT NOT LEAST IS PATRICE WASHINGTON, FORMER FOSTER YOUTH, AND WE'RE GOING TO ASK HER TO SAY A COUPLE OF WORDS ON BEHALF OF ALL THE HONOREES. PATRICE ENTERED FOSTER CARE AT THE AGE OF SIX, WHERE SHE WAS SEPARATED FROM HER FIVE BROTHERS AND SISTERS. SHE IS A LEGAL STUDIES MAJOR AT THE UNIVERSITY OF CALIFORNIA AT BERKELEY, GO BEARS. DURING HER SUMMER BREAKS, SHE WORKED FOR A JUDGE AND THE ALLIANCE FOR CHILDREN'S RIGHTS. HER OWN SUCCESS IS A MOTIVATION FOR OTHER FOSTER YOUTHS AND SHE ALSO IS PURSUING A LEGAL CAREER IN ORDER TO HELP CHILDREN IN THE FOSTER CARE SYSTEM. LET'S WELCOME OUR FINAL HONOREE, PATRICE WASHINGTON. [ APPLAUSE ] 

SUP. YAROSLAVSKY: OKAY, AND YOU'LL SAY A COUPLE OF WORDS. 

PATRICE WASHINGTON: HELLO. IT IS AN HONOR TO ACCEPT THIS AWARD ON BEHALF OF ALL THE HEROES HERE TODAY. EACH OF THE HEROES HAS HELPED IMPROVE THE LIVES OF FAMILIES AND CHILDREN IN THEIR OWN WAY, AND ALTHOUGH WE REPRESENT EIGHT, THERE ARE MILLIONS OF HEROES OUT THERE, AND ONCE WE FORM A TIGHTER LINK, WE CAN MAKE SURE THAT NO CHILD IS LEFT ALONE AND NO KID AND NO FAMILIES FALL THROUGH THE CRACK. THANK YOU. [ APPLAUSE ] 

SUP. YAROSLAVSKY: ALL RIGHT. WE DON'T HAVE ANY MORE? ALL RIGHT, I THINK THAT TAKES CARE OF THE PROCLAMATIONS FOR THE PRESENTATIONS FOR THIS MORNING, SO WE'LL GO BACK TO THE AGENDA. MR. KNABE, YOU'RE UP FIRST THIS MORNING. 

SUP. KNABE: ALL RIGHT, SIR. BEGIN WITH MY ADJOURNMENTS. FIRST OF ALL, I'D LIKE TO MOVE THAT WE ADJOURN IN MEMORY OF MR. STEVE FELD. STEVE IS A LIFELONG RESIDENT OF HACIENDA HEIGHTS WHO DIED OF AN APPARENT HEART ATTACK WHILE ON A HIKING TOUR IN BOLIVIA. HE WAS A NOTED SIERRA CLUB HIKE LEADER FOR THE LOS ANGELES CHAPTER, HAVING ORGANIZED NUMEROUS HIKES IN THE PUENTE HILLS OF LOS ANGELES COUNTY, MOST NOTABLY THE SINGLES HIKE HELD WEEKLY AT TWILIGHT AT THE HACIENDA HILLS TRAIL HEAD. HE WAS ALSO A VERY LOYAL AND DEDICATED MEMBER OF THE HACIENDA HEIGHTS COMMUNITY WHO CONSISTENTLY DEDICATED HIMSELF TO HELPING OTHERS. HE WAS A LIFELONG ADVOCATE FOR PUENTE-CHINO HILLS WILDLIFE CORRIDOR, HE WAS AN EAGLE SCOUT, PAST PRESIDENT OF THE CHAMBER OF COMMERCE, HE WAS THE CURRENT PRESIDENT OF THE HACIENDA HEIGHTS KIWANIS CLUB, A MEMBER OF THE BOARD OF DIRECTORS OF THE WHITTIER HOSPITAL MEDICAL CENTER, HE'S A PAST PRESIDENT OF THE CORRIDOR CONSERVATION AUTHORITY AND HAS BEEN A MEMBER FOR YEARS OF THE HACIENDA HEIGHTS FOURTH OF JULY PARADE COMMITTEE, AS WELL AS THE HACIENDA HEIGHTS IMPROVEMENT ASSOCIATIONS AND MANY OTHER CLUBS AND ORGANIZATIONS. HE IS SURVIVED BY HIS GIRLFRIEND CAROL, ALSO SURVIVED BY HIS SON BRIAN, DAUGHTER JESSICA, AND HIS EX-WIFE, OLGA. HE WILL BE SORELY MISSED. PASSED AWAY AT THE YOUNG AGE OF 59, AN APPARENT HEART ATTACK. ALSO THAT WE ADJOURN IN MEMORY OF PASCAL KAMAR, WHO WAS A LONG TIME RESIDENT OF THE PALOS VERDES PENINSULA. HE WAS THE MASTER TOY MAKER WHO CREATED THE FAMOUS "E.T." DOLLS, AMONGST MANY OTHER DOLLS. HE DIED FROM DIABETES RECENTLY. HE WAS 83. THE FAMILY-RUN BUSINESS, KAMAR INTERNATIONAL, HAD 400 TOYS IN ITS MENAGERIE BUT STOPPED MAKING EVERYTHING BUT "E.T." AND GEARED UP TO TRY TO HAVE MILLIONS OF DOLLS IN STORES BY CHRISTMAS IN 1983. AFTER THE COMPANY WAS CHOSEN TO PRODUCE "E.T.," AN EXECUTIVE FROM THE MOVIE TOOK HIS CHILDREN TO A STORE ASKING THEM TO PICK OUT THEIR FAVORITE STUFFED ANIMAL, AND THE CHILDREN CHOSE KAMAR'S MONKEY DO, A STUFFED MONKEY DOLL WITH THE OVERLONG ARMS, SIMILAR TO WHAT "E.T." WOULD EVENTUALLY BECOME. HE'S SURVIVED BY HIS SON CHRISTOPHER, DAUGHTERS JENNY AND LAURIE, HIS COMPANION ALICE, HIS BROTHER AND TWO GRANDCHILDREN. ALSO THAT WE ADJOURN IN MEMORY OF MELVIN SWERDLING. MELVIN IS THE FATHER OF MY FORMER DEPUTY, LINDA TARNOFF, WHO PASSED AWAY YESTERDAY MORNING AFTER A LONG STRUGGLE WITH CANCER AT THE AGE OF 83. HE WAS A RESIDENT OF NORTH HILLS, CALIFORNIA. BY PROFESSION, MEL WAS A RENOWNED AERONAUTICAL AND SPACE ENGINEER, HAVING DEDICATED HIS EXPERTISE AT LOCKHEED, NORTHROP JET PROPULSION LABORATORIES AND TRW IN REDONDO BEACH. HOWEVER, THROUGHOUT HIS ENTIRE LIFE HE WAS CONSUMED BY A PASSION FOR BASEBALL. IN ADDITION TO HIS DAUGHTER LINDA, HE LEAVES BEHIND A SON MICHAEL, HIS WIFE OF OVER 20 YEARS, INGA, AND HER LOVING CHILDREN, GRANDCHILDREN AND GREAT GRANDCHILDREN WHO LOVE HIM AS THEIR OWN. HE SHALL BE TRULY MISSED BY ALL THOSE LIVES WHO WERE TOUCHED BY HIM. 

SUP. BURKE: I'D LIKE TO JOIN IN THAT. 

SUP. KNABE: OKAY. ALL MEMBERS. ALSO THAT WE ADJOURN IN MEMORY OF CAROLYN BAINTON, WHO PASSED AWAY AT THE YOUNG AGE OF 56. CAROLYN WAS A LIFELONG RESIDENT OF LOS ANGELES COUNTY, SHE WAS LIVING IN TORRANCE AT THE TIME OF HER PASSING. SHE WAS AN AVID PLAYER OF THE SLOTS IN VEGAS AND LAUGHLIN AND SHE LOVED SOUTHERN CALIFORNIA THOUGH. SHE ENJOYED DOING HER DAILY CROSSWORD PUZZLES IN THE NEWSPAPER AND SHE LOVED SPENDING AN AFTERNOON RELAXING WITH HER DOGS, BEAR AND LUCKY, AROUND THE POOL. SHE'S SURVIVED BY HER HUSBAND KEVIN, HER SON TYSON, HER BROTHER TOM, AND GRANDCHILDREN COURTNEY AND BRITNEY. ALSO THAT WE ADJOURN IN MEMORY OF GUADALUPE CONTRERAS, WHO PASSED AWAY MAY 5TH AT THE YOUNG AGE OF 36. SHE WAS A RESIDENT OF NORWALK AND A SANTE FE CITY EMPLOYEE FOR THE DEPARTMENT OF PARKS AND RECREATION, AS WELL AS A TEACHER AT SANTA FE HIGH SCHOOL. SHE IS SURVIVED BY HER PARENTS, GILBERT AND SYLVIA, TWO BROTHERS, GILBERT, RICHARD, AND A SISTER, FRANCES. SHE WAS VERY ACTIVE IN THE COMMUNITY, ALWAYS HELPING IN ONE WAY OR ANOTHER, COACHING, ASSISTING ANY WAY SHE COULD IN THE MANY ACTIVITIES OFFERED BY THE DEPARTMENT OF PARKS AND REC AS WELL AS SANTA FE HIGH SCHOOL. SHE'LL BE SORELY MISSED BY ALL. AND THOSE ARE MY ADJOURNMENTS. 

SUP. YAROSLAVSKY: SO ORDERED. 

SUP. KNABE: I HELD ITEMS 16 AND, I BELIEVE, 34, AND BOTH OF THESE ITEMS, I MEAN, I JUST, IF YOU REMEMBER, I MENTIONED AN ONGOING CONCERN A COUPLE OF WEEKS AGO AND WAS CONCERNED ABOUT THIS USE IT OR LOSE IT MINDSET WITH REGARD TO MANAGING THEIR BUDGET. SO I REALLY FEEL THAT ANY SAVINGS SHOULD BE CHALKED UP TO MORE EFFICIENT COUNTY GOVERNMENT THAT WILL BENEFIT THE TAXPAYERS, AND I REQUESTED A REPORT A FEW WEEKS AGO ON A COUNTY-WIDE BASIS OF WHAT'S GOING ON, AND WE HAVE NOT SEEN THE REPORT YET AND JUST WANTED TO CHECK WITH THE C.A.O. TO SEE WHERE THAT IS, IF IT'S ALMOST COMPLETED, BECAUSE I MEAN, HERE'S TWO MORE. DO WE HAVE ANY IDEA? 

C.A.O. JANSSEN: TWO WEEKS. 

SUP. KNABE: TWO WEEKS? 

C.A.O. JANSSEN: BUT LET ME, COULD I ADDRESS THESE TWO ITEMS, BECAUSE I THINK IT'S IMPORTANT THAT YOU UNDERSTAND WHAT'S BEHIND THEM. ON THE FIRST ONE, THE PARKS ITEM, THE $2.2 MILLION IS FOR EXISTING OBLIGATIONS, $800,000 INCREASE IN WATER, 300,000 ELECTRICITY, 127,000 NATURAL GAS, 250,000 GASOLINE, SO THERE IS SEEN THE INCREASED COST OF DOING BUSINESS THAT WE'RE GOING TO HAVE TO COVER ONE WAY OR THE OTHER. ANOTHER 700,000 HAS TO DO WITH PROJECT MANAGEMENT SUPPORT USING CONTRACT EMPLOYEES UNTIL THEY CAN FILL THE POSITION, SO IN THAT CASE, WE THINK THAT IT IS VERY WELL JUSTIFIED IN TERMS OF THE OPERATION. ON AFFIRMATIVE ACTION, JUST TO WRAP IT UP, THIS IS A RENOVATION PROJECT THAT WAS APPROVED IN LAST YEAR'S BUDGET. THEY DID PHASE I LAST YEAR. THE REMAINING MONEY WAS CARRIED OVER THIS YEAR. THE ADDITIONAL 43,000 IS INCREASED COST OF DOING BUSINESS FOR THAT PROJECT, SO WE ARE CONCERNED ABOUT THE ISSUE THAT YOU RAISED, WE ARE TRACKING IT, THE REPORT WILL BE THERE IN TWO WEEKS, BUT I THINK THESE TWO FIT A REASONABLE CRITERIA. 

SUP. KNABE: OH, ABSOLUTELY, I MEAN AND THE OTHERS THAT I HELD BEFORE, I MEAN THE PROJECTS THEMSELVES AS IT RELATES TO PARKS AND REC AND THEIR INCREASED COST AS IT RELATES TO AFFIRMATIVE ACTION, I HAVE NO PROBLEM WITH THE -- JUST THAT THE TIMING, YOU KNOW, WE DON'T SEE SALARY SAVINGS, YOU KNOW, UNTIL JUST PRIOR TO A BUDGET DELIBERATION, AND I UNDERSTAND THEY DON'T ACCUMULATE IT TO THAT POINT, BUT IT JUST -- THE TIMING SEEMS RATHER UNIQUE. 

C.A.O. JANSSEN: OKAY. 

SUP. KNABE: SORT OF LIKE THE SEPTEMBER AND MARCH MIRACLES, BUT THAT'S THE OLD DAYS OKAY. ANYWAY, WITH THAT, MR. CHAIRMAN, I WOULD MOVE BOTH ITEMS. 

SUP. YAROSLAVSKY: ALL RIGHT, WE HAVE ONE PERSON IN THE PUBLIC WHO WANTED TO BE HEARD, ANDREW AHLERING. IS HE HERE? 16. YEAH, YOU ALSO HELD ITEM 1-D, SO WE'LL HAVE YOU SPEAK TO BOTH OF THEM AT THIS TIME. 

ANDREW AHLERING: YES, SUPERVISOR, YOU'RE GIVING ME THREE MINUTES FOR ALL THREE OF MY ITEMS OR THREE MINUTES PER ITEM? 

SUP. YAROSLAVSKY: YES, YEAH, THAT'S WHAT WE'RE DOING. YOU KNOW THE DRILL. 

ANDREW AHLERING: ALL RIGHT, I WOULD LIKE THE RECORD TO REFLECT THAT I AM OBJECTING TO THE BOARD DOING THAT, BUT THAT IS YOUR -- 

SUP. YAROSLAVSKY: RIGHT, THE RECORD WILL SO REFLECT. GO AHEAD. 

ANDREW AHLERING: THANK YOU SIR. THANK YOU FOR INVITING ME BACK, SUPERVISOR MOLINA, ALTHOUGH YOU'RE NOT HERE. I SPOKE WITH YOUR CHIEF OF STAFF AND I HAD AN INVITATION TO COME BACK. I WAS IN THIS COUNTY'S FABULOUS JAIL FACILITY FOR 23 DAYS AFTER I WAS ARRESTED IN THE BACK OF THIS ROOM, RIGHT UP THERE, BY UNDERCOVER SERGEANT DEPUTIES, SOME OF WHICH ARE OVER HERE. I HAVE A GIFT FOR THE COUNTY. ONE IS FOR MR. JANSSEN. IT'S A WHITE ROSE. I ACTUALLY HAVE 10 WHITE ROSES, ONE WAS LEFT OVER THERE AND I GAVE IT TO DEPUTY REAL, WHO ARRESTED ME. I HAVE ONE WHITE ROSE FOR EACH SUPERVISORIAL DISTRICT, ALSO ONE FOR THE COUNTY COUNSEL, ONE FOR THE EXECUTIVE OFFICE OF THE BOARD, ONE FOR THE SERGEANT-OF-ARMS WHO ARRESTED ME, AND I DON'T KNOW HOW MANY -- WAS THAT FIVE? 

SUP. KNABE: ONE FOR MIGUEL. 

ANDREW AHLERING: IS THAT NINE? WHO AM I FORGETTING? ANOTHER ONE FOR AN UNDERCOVER DEPUTY WHO ARRESTED ME. SO I WILL LEAVE THESE UP HERE AND YOU CAN DISTRIBUTE THEM AS YOU SEE FIT. THEY HAVE NO VALUE, SO YOU DON'T HAVE TO WORRY ABOUT THE FAIR POLITICAL PRACTICE OF THE REPORTING COMMISSION. WHILE I WAS IN SHERIFF BACA'S MEN'S CENTRAL JAIL, I WAS IN THE CENTRAL JAIL TWO DAYS PRIOR TO THE FEDERAL JUDGE TAKING A TOUR, AND I CAN LET YOU KNOW, I AGREED WITH WHAT THE JUDGE HAS SAID PUBLICLY, THAT JAIL IS A SHAME TO OUR COUNTY, AND THE MEN'S CENTRAL JAIL CAN MAKE ABU GHRAIB LOOK LIKE SUMMER CAMP. THIS COUNTY SHOULD BE EMBARRASSED TO OPERATE THE MEN'S CENTRAL JAIL, AND THIS COUNTY SHOULD BE EMBARRASSED FOR ARRESTING A CANDIDATE FOR THE BOARD OF SUPERVISORS. EARLIER IN THIS MEETING, YOU CONGRATULATED AN EMPLOYEE FROM THE DEPARTMENT OF MENTAL HEALTH, I BELIEVE HER FIRST NAME WAS CARMEN. YES. IT WAS CARMEN FROM MENTAL HEALTH. AND OF CARMEN FROM MENTAL HEALTH, YOU CONGRATULATED HER AND THE DEPARTMENT HAD SAID THAT SHE WAS THE FUTURE OF MENTAL HEALTH. WELL, IF THE PEOPLE OF LOS ANGELES COUNTY SO DESIRE, I CAN BE THE FUTURE OF THE BOARD OF SUPERVISORS, BUT THAT IS FOR THE PEOPLE TO DECIDE ON JUNE 6TH. THAT IS NOT FOR THIS BOARD. LADIES AND GENTLEMEN IN FRONT OF ME, SUPERVISORS KNABE, BURKE, AND YAROSLAVSKY, YOU ALL KNOW YOUR ELECTED REPRESENTATIVES. YOU ARE NOT THE GOVERNMENT. AS I SAID THE DAY I WAS ARRESTED, AND SUPERVISOR BURKE, YOU WEREN'T HERE SO MAYBE YOU DIDN'T SEE THE TRANSCRIPT, THE GOVERNMENT SITS IN FRONT OF YOU. THE GOVERNMENT'S NOT CURRENTLY HERE. WELL, SOME OF THE GOVERNMENT'S HERE, BUT THERE'S NOT THAT MANY PEOPLE. WHY? BECAUSE THE BUSINESS OF THE PEOPLE IS OUT ON THE STREETS OF THE COUNTY OF LOS ANGELES, AND TO THERE I WILL BE GOING AS SOON AS I AM DONE ADDRESSING THIS HONORABLE BOARD. AFTER MY HEAD WAS BASHED INTO A WALL IN YOUR EXECUTIVE ELEVATOR, BY SERGEANT COOKE, WHO I DON'T BELIEVE IS OVER HERE ON MY LEFT, SHE STEPPED OUT OF THE ROOM AFTER I NOTICED I WAS HERE, SERGEANT COOKE IS NOW THE SUBJECT OF AN I.A. INVESTIGATION FROM THE SHERIFF'S DEPARTMENT, AND I ASK THAT THE I.A. PLEASE CONTACT ME. I WILL LEAVE MY PHONE NUMBER WITH ANY DEPUTY FROM ANY SUPERVISORIAL DISTRICT THAT IS INTERESTED IN CONTACTING ME. OR, ACTUALLY, I'LL SAY MY PHONE NUMBER. I CAN CURRENTLY BE REACHED AT 702-821-5125, AND I ASK THE COUNTY OF LOS ANGELES, DEPARTMENT OF SHERIFF, INTERNAL AFFAIRS SECTION TO PLEASE CONTACT ME REGARDING THE INAPPROPRIATE BATTERY THAT OCCURRED IN THE HALL OF ADMINISTRATION. I AM A RESIDENT OF LOS ANGELES COUNTY. I SHOULD NOT BE SCARED THAT I WILL BE ILLEGALLY ASSAULTED AND BATTERED BY UNDERCOVER DEPUTIES IN THIS HALL OF ADMINISTRATION. REGARDING AFFIRMATIVE ACTION, ITEM 16, AND I WOULD APPRECIATE IF THE ACTING CHAIR DOESN'T CUT ME OFF WHEN MY TWO REMAINING MINUTES ARE UP, BUT IF HE DOES, THAT'S FINE, I RESPECT THAT. WHILE I WAS IN THE MEN'S CENTRAL JAIL, I HAD A VISIT. IT WAS DEEMED TO BE AN ATTORNEY'S VISIT. WHEN I PROCEEDED DOWN TO THE ATTORNEY'S VISIT WINDOW, THIS WAS MAY 2ND, THE DAY AFTER THE BOYCOTT, WHAT DID I FIND? IT WAS A NOTE. WHO WAS VISITING ME? THE COUNTY OF LOS ANGELES DEPARTMENT OF PUBLIC WORKS, MY EMPLOYER. AND WHO WAS IT? IT WAS MRS. ZA-ZA MAXWELL. MS. MAXWELL, IF YOU DON'T KNOW THE NAME, IS FROM DISCIPLINE AND ADVOCACY. I REJECTED, AND THIS IS IN THE SHERIFF'S DEPARTMENT'S RECORDS, I DID NOT SEE MS. MAXWELL THAT DAY AT THE COUNTER BECAUSE I DIDN'T BELIEVE THAT MS. MAXWELL HAD GOOD NEWS FOR ME. WHEN I GOT HOME, I DIDN'T HAVE ANY MAIL IN MY MAILBOX. THANKFULLY IT WAS ALL AT THE ALAMEDA STATION. I WENT TO THE ALAMEDA STATION AND I PICKED IT UP AND I HAVE THIS ENVELOPE RIGHT HERE, AND YOU'LL SEE IT'S STILL SEALED. I'D LIKE TO OPEN THIS FOR THE RECORD, SO I'M NOW OPENING THE SEALED ENVELOPE, AND IT'S ADDRESSED TO ME AT MY APARTMENT, 306 WEST THIRD STREET, AND I WON'T SAY THE APARTMENT NUMBER, IT WAS MAILED ON MAY 3RD FROM ALHAMBRA, CALIFORNIA, AND ZIP CODE 91803. IT'S FROM H.R. AND ADVOCACY AT THE L.A. COUNTY DEPARTMENT OF PUBLIC WORKS. FOR THE RECORD, I AM NOW OPENING THE SEALED ENVELOPE. INSIDE I HAVE FOUND A LETTER. THE LETTER IS ENTITLED "NOTICE OF INTENT TO DISCHARGE" AND IT IS ADDRESSED TO ME. IT IS SENT CERTIFIED FIRST CLASS AND HAND DELIVERED. I DID NOT RECEIVE THE HAND DELIVERY. IT WAS SENT BACK CERTIFIED AND THIS IS THE FIRST TIME I'VE SEEN IT HAND DELIVERED. I WILL BE PASSING THIS ON TO MY LAWYERS TO ADDRESS AT A FUTURE PROCEEDING. 

SUP. YAROSLAVSKY: OKAY. THANK YOU. 

ANDREW AHLERING: THANK YOU. 

SUP. YAROSLAVSKY: WITHOUT -- MR. KNABE YOU MOVE AND MS. BURKE SECONDS ON ITEM 16. 

SUP. KNABE: AND 34. 

SUP. YAROSLAVSKY: AND 34. WITHOUT OBJECTION, UNANIMOUS VOTE. ANYTHING ELSE, DON? 

SUP. KNABE: I HELD NO OTHERS. THANK YOU. 

SUP. YAROSLAVSKY: ALL RIGHT. MS. BURKE? 

SUP. BURKE: I HAVE SOME ADJOURNMENTS. I MOVE THAT WHEN WE ADJOURN TODAY WE ADJOURN IN MEMORY OF THADDEUS WATSON, HE WAS MY COUSIN, A LONG-TIME RESIDENT OF THE SECOND DISTRICT, WHO PASSED AWAY MAY 15TH, 2006, AT THE AGE OF 82. HE WAS BORN IN PARIS, TEXAS. HE WAS A VETERAN OF BOTH WORLD WAR II AND THE KOREAN CONFLICT. HE WAS A PURPLE HEART RECIPIENT. AFTER AN HONORABLE DISCHARGE, HE SERVED 33 YEARS FOR THE U.S. POSTAL SERVICE. HE WAS A LOVING AND SUPPORTIVE SON, FATHER, AND GRANDFATHER. HE WILL BE GREATLY MISSED. HE WAS PRECEDED IN DEATH BY HIS WIFE OF 31 YEARS, EDITH DELORES WATSON. HE'S SURVIVED BY HIS FIVE CHILDREN AND OF HIS CHILDREN I THINK TWO OF THEM ARE PHYSICIANS, ONE IS A FLAUTIST IN GERMANY AND ONE IS AN ENGINEER, AND THEY ARE THADDEUS WATSON, BLANCHE WATSON, MARILYN MALAY, ANITA WATSON AND THURSTON WATSON. HE HAS NINE GRANDCHILDREN, TWO STEP GRANDCHILDREN AS WELL AS A HOST OF OTHER RELATIVES AND FRIENDS, AND HE CERTAINLY WAS A RELATIVE THAT I KNEW OVER THE YEARS AND ADMIRED SO VERY MUCH, HE'S NAMED AFTER MY DAD. AND MRS. EDDIE CRISPELL, WHO PASSED AWAY ON MAY 3RD, 2006, SHE WAS THE OWNER OF EDDIE CRISPELL'S OF HOLLYWOOD, FORTY-SIX YEARS SHE WAS IN BUSINESS. SHE LEAVES HER HUSBAND NICK MITCHELL TO CHERISH HER MEMORY AND SHE WAS ALWAYS ON PUBLIC SERVICE T.V. IN BEVERLY HILLS, BUT SHE WAS CERTAINLY A PERSON THAT EVERYONE ENJOYED GOING INTO HER BARBER SHOP. MARGARET MARIE WESSON, WHO WAS BORN JULY 11TH, 1920, AND PASSED AWAY ON MAY 8TH, 2006 AT THE AGE OF 85. SHE WAS A LONG-TIME RESIDENT OF THE SECOND DISTRICT FOR OVER 70 YEARS. SHE LEAVES TO CHERISH HER MEMORY HER SISTER PATRICIA MILLER, DEPUTY IN MY OFFICE, HER THREE CHILDREN, DENISE WESSON-EVANS, JULIUS WESSON AND JAMIE M. WESSON, AND A SON-IN-LAW IRWIN S. EVANS AND NUMEROUS RELATIVES, INCLUDING GRANDCHILDREN, NIECES AND NEPHEWS, COUSINS AND MANY FRIENDS, AND OF COURSE HER SISTER IS PAT IN OUR OFFICE. FLOYD PATTERSON, HEAVYWEIGHT BOXING CHAMPION PASSED AWAY -- 

SUP. KNABE: I'D LIKE TO JOIN IN THAT ONE AS WELL FOR PAT. 

SUP. BURKE: ON MAY 11TH, 2006 AT THE AGE OF 71 OF ALZHEIMER'S DISEASE. WE ALL KNOW THE HISTORY OF FLOYD PATTERSON, WE KNOW OF HIS RECORDS AND ALL OF THE THINGS THAT HE ACHIEVED OVER THE YEARS AND WAS SO WELL THOUGHT OF IN THE BOXING PROFESSION. AND RACHEL EUBANKS, CLAIMS MANAGER FOR THE VONS COMPANY. SHE WAS AN EXTRAORDINARY BUSINESSWOMAN AND COMMUNITY SERVANT WHO MADE POSITIVE AND SIGNIFICANT CONTRIBUTIONS IN ADDRESSING THE STATEWIDE PROBLEM OF REDUCING RUNAWAY WORKER COMPENSATION COSTS. SHE PASSED AWAY ON APRIL 27TH, 2006 OF CANCER. AND JULIUS BABBITT, DIRECTOR OF ALUMNI PROGRAMS, KENNEDY SCHOOL OF GOVERNMENT, HARVARD UNIVERSITY. AND I ALSO WANT TO ADJOURN IN MEMORY OF MRS. EUBANKS OF THE CONSERVANCY WHO HAD THE MUSIC CONSERVATORY THAT PROVIDED MUSIC TRAINING FOR SO MANY YOUNG PEOPLE OVER THE YEARS IN OUR DISTRICT. AND I JUST -- I MIGHT WANT TO CORRECT WHAT I HAVE HERE, BUT CERTAINLY WE WANT TO ADJOURN IN MEMORY OF MRS. EUBANKS FOR ALL OF OUR CONTRIBUTIONS TO MUSIC TRAINING FOR YOUNG PEOPLE. 

SUP. YAROSLAVSKY: OKAY. WITHOUT OBJECTION, I'D LIKE TO ALSO BE ADDED, ALL MEMBERS ON FLOYD PATTERSON. I REMEMBER AS A BOY LISTENING TO RADIO BROADCASTS OF HIS BOXING MATCHES. I WASN'T MUCH OF A BOXING FAN, BUT I WAS A FAN OF HIS BECAUSE HE WAS SUCH A -- JUST IMPRESSED ME AS SUCH A GREAT HUMAN BEING. AND I THINK HE WAS THE FIRST HEAVYWEIGHT TO RECLAIM THE CHAMPIONSHIP AFTER LOSING IT. 

SUP. KNABE: RIGHT AFTER THE OLYMPICS, YEAH. 

SUP. YAROSLAVSKY: IN THE LATE '50S, EARLY '60S, I FORGOT THE YEAR. BUT ANYWAY, I WAS A BIG FAN OF HIS, AND HE DIED TOO YOUNG. SO ALL MEMBERS ON THAT, AND UNANIMOUS VOTE ON ALL THE ADJOURNING MOTIONS FOR MS. BURKE. DO YOU WANT TO CALL ANYTHING UP OR? 

SUP. BURKE: I HAVE NOTHING, BUT I'M GOING TO HAVE TO CORRECT MY ADJOURNMENTS -- 

SUP. YAROSLAVSKY: SURE. 

SUP. BURKE: I THINK THEY'RE INCORRECT, ONE OF THEM IS INCORRECT. 

SUP. YAROSLAVSKY: ALL RIGHT. WELL WE'LL TRUST YOU ON THAT, BUT JUST MAKE SURE YOU GET A COPY OF IT TO EACH OF US BEFORE -- NO. JUST JOKING. 

SUP. BURKE: SURE. [ LIGHT LAUGHTER ] 

SUP. YAROSLAVSKY: WE HAD ITEM 1-D AND 4-D ALSO THAT WERE HELD FOR THE SAME MEMBER OF THE PUBLIC, SO I'M GOING TO MOVE APPROVAL OF ITEM 1-D AND ITEM 4-D. SECONDED BY MR. KNABE. UNANIMOUS VOTE. AND I HAVE SOME ADJOURNING MOTIONS AND I HAVE SOME FOR MR. ANTONOVICH AS WELL. ON MINE, I HAVE ONE FOR MS. MOLINA, THAT WE ADJOURN TODAY IN THE MEMORY OF BETH ANN HOFFMANN, WHO'S THE DAUGHTER OF RON HOFFMANN, A MEMBER OF THE COUNTY FAMILY, AN ADMINISTRATOR IN THE DEPARTMENT OF REGIONAL PLANNING, WHO RECENTLY PASSED AWAY AND -- 

SUP. KNABE: I'D LIKE TO JOIN IN THAT TOO. 

SUP. YAROSLAVSKY: ALL MEMBERS. DOUGLAS ROBERT CRISWELL, THIS IS FOR ME, ADJOURNING MOTIONS THAT I'M MAKING, DOUGLAS ROBERT CHRISWELL, A LONG-TIME RESIDENT OF OUR DISTRICT, A TALENTED CARPENTER AND PLUMBER, ACTIVE IN THE COMMUNITY IN ROSITA, A STRONG SUPPORTER OF SOBER-LIVING PROGRAMS AND A MUSIC LOVER AND DEVOTED FATHER WHO LOVED SPENDING TIME WITH HIS KIDS. HE WILL BE MISSED BY HIS FAMILY AND FRIENDS, SURVIVED BY HIS MOTHER CAROLYN, TWO CHILDREN, KENNY AND ALISON, A BROTHER GREG AND A SISTER KIM. I ALSO ASK THAT WE ADJOURN IN THE MEMORY OF SUE CUNITOMI EMBRY, WHO PASSED AWAY AT THE AGE OF 83. SUE WAS A -- I FIRST GOT TO KNOW HER WHEN SHE WAS A, I BELIEVE, A CIVIL SERVICE COMMISSIONER IN THE CITY OF LOS ANGELES, MAYOR BRADLEY HAD APPOINTED HER TO THAT POSITION. SHE WAS ONE OF THE PEOPLE WHO SINGLE HANDEDLY FOUGHT TO MAKE MANZANAR A HISTORICAL MONUMENT BUT FIRST A STATE, THEN A NATIONAL HISTORICAL MONUMENT IN COMMEMORATION OF THE EVENTS THAT TOOK PLACE THERE DURING WORLD WAR II. SHE WAS A PASSIONATE ADVOCATE ON BEHALF OF EDUCATING FUTURE GENERATIONS TO THE INTERNMENT CAMPS, AND SHE PASSED AWAY LAST WEEK. WITH NO OBJECTION -- WITHOUT OBJECTION, THOSE WILL BE APPROVED, THOSE. AND NOW I HAVE SOME FOR MR. ANTONOVICH. ADJOURN IN THE MEMORY OF FRANK XAVIER SULLIVAN, WHO PASSED AWAY, A GRADUATE OF LOYOLA MARYMOUNT AND L.A. MISSION COLLEGE. HE WAS A MEMBER OF THE LOS ANGELES CITY FIRE DEPARTMENT FROM 1961 UNTIL 1986, RETIRED WITH THE RANK OF CAPTAIN. AND HE IS SURVIVED BY HIS CHILDREN ELAINE SULLIVAN AND GEOFFREY SHERWOOD AND FRANK AND GYSELA SULLIVAN. HOWARD FERRAND, SURVIVED BY HIS WIFE NANCY, HIS TWO SONS BOB AND JIM, AND SEVERAL GRANDCHILDREN. CARLOS AVILA, RETIRED SERGEANT OF THE L.A. COUNTY SHERIFF'S DEPARTMENT. HIS LAST ASSIGNMENT WAS AT HOMICIDE BUREAU, HE SERVED FROM JULY 26TH, 1960, TO JUNE OF 1991. LARRY ATERBERRY, AND I THINK ALL OF THE MEMBERS WOULD LIKE TO JOIN ON THAT. LARRY ATTEBERY, AN AWARD WINNING BROADCAST JOURNALIST, WHO COVERED LOS ANGELES FOR MORE THAN THREE DECADES, INCLUDING STINTS AS AN ANCHOR AND NEWS DIRECTOR AT KTTV CHANNEL 11, AS A REPORTER FOR KCOP-TV CHANNEL 13. PASSED AWAY AT THE AGE OF 73. A GRADUATE OF NORTHWESTERN UNIVERSITY, MADILL SCHOOL OF JOURNALISM, SERVED AS A JOURNALIST DURING HIS TIME IN THE NAVY. ATTEBERY WAS ALSO A PAST PRESIDENT OF THE LOS ANGELES PRESS CLUB, AND OF THE RADIO AND TELEVISION NEWS ASSOCIATION OF SOUTHERN CALIFORNIA. HE IS SURVIVED BY HIS WIFE CAROL, TWO DAUGHTERS, TARA PHELPS AND MICHELLE ATTEBERY, A SISTER DONNA ATTEBERY, AND TWO GRANDCHILDREN. I'LL JUST ADD THAT I KNEW LARRY FROM THE TIME BEFORE I WAS AN ELECTED OFFICIAL AND HE WAS A NEWS MAN'S NEWS MAN. JUST ONE OF THE OLD LINE STRAIGHT SHOOTERS AND HE CALLED THEM AS HE SAW THEM, NO SPIN, THE REALLY NO SPIN, AND HE WILL BE SORELY MISSED. DIANA JONSSON, HELPED FOUND THE JONSSON COMPREHENSIVE CANCER CENTER AT U.C.L.A. WITH HER HUSBAND. SHE DIED ON APRIL 28TH AT THE AGE OF 76. AN ART ENTHUSIAST WHO VOLUNTEERED AS A L.A.C.M.A. DOCENT FOR MORE THAN 30 YEARS. RONALD MILLS, RETIRED LIEUTENANT OF THE L.A. COUNTY SHERIFF'S DEPARTMENT, DIED AT THE AGE OF 59. ROBERT "BOB" RADICH DIED IN TUCSON, ARIZONA, HE WAS A FOUNDER OF THE RADICH CONSTRUCTION INCORPORATED AT GENERAL ENGINEERING CONSTRUCTION FIRM LOCATED IN SIMI VALLEY, AND SPECIALIZING IN PIPELINE CONSTRUCTION AND FLOOD CONTROL. HE WAS A MEMBER OF THE ST. STEVENS SERBIAN ORTHODOX CATHEDRAL IN ALHAMBRA, WHERE HE GREW UP AND DEVELOPED HIS CHARACTER. NANCI ANN THOMAS. NANCI WAS BORN IN -- I'M SORRY, BORN AND RAISED IN GLENDALE, SHE ATTENDED GLENDALE PUBLIC SCHOOLS, COMMUNITY COLLEGE, ORANGE COAST COMMUNITY COLLEGE, AND U.S.C. SHE WORKED IN THE FASHION INDUSTRY FOR MANY YEARS, PRIMARILY AS A SUCCESSFUL SALES REPRESENTATIVE, A MANAGER FOR SEVERAL FASHION COMPANIES. AND THOMAS HARNETT, A RETIRED DEPUTY OF THE SHERIFF'S DEPARTMENT FOR OVER 30 YEARS, PASSED AWAY LAST WEEK. LINDA MENARY, DIED AT THE AGE OF 61. HER PARENTS DIED IN A PLANE CRASH WHEN SHE WAS 17. SHE THEN TOOK HER PONY INTO THE CITY AND OFFERED CHILDREN RIDES FOR PENNIES. A PASSERBY SAID SHE WOULD PAY HER $5 MORE THAN SHE HAD MADE ALL DAY TO BRING THE PONY TO HIS SON'S BIRTHDAY PARTY. SHE THEN MOVED TO SOUTHERN CALIFORNIA WHERE SHE STARTED HER ANIMAL EMPORIUM IN 1961. FOR DECADES, A SUBURBAN BARNYARD IN RESEDA, THAT SHE CALLED "THE FARM" INTRODUCED CITY KIDS TO PONY RIDES AND PETTING ZOOS AND SHE FIGURED SHE WAS THE LAST HOPE TO KEEP THE RANCH LIFESTYLE IN THE SAN FERNANDO VALLEY. THOSE ARE HIS ADJOURNING MOTIONS. WITHOUT OBJECTION, UNANIMOUS VOTE. 

SUP. KNABE: MR. CHAIRMAN? 

SUP. BURKE: I'D LIKE TO CORRECT MINE IF I CAN. 

SUP. KNABE: GO AHEAD. 

SUP. YAROSLAVSKY: MS. BURKE FIRST AND THEN -- GO AHEAD MS. BURKE. 

SUP. BURKE: I'D LIKE TO ADD, I'D LIKE TO MOVE THAT WE ADJOURN IN MEMORY OF JULIUS BABBET, DIRECTOR OF ALUMNI PROGRAMS KENNEDY SCHOOL OF GOVERNMENT AT HARVARD. AND ALSO FOR RACHEL EUBANKS, SHE PASSED AWAY APRIL 8TH OF CANCER AT THE AGE OF 83. FOR MORE THAN 50 YEARS, MANY OF THOSE YEARS SHE TAUGHT MUSIC IN LOS ANGELES AT THE EUBANKS CONSERVATORY OF MUSIC AND ARTS ON CRENSHAW BOULEVARD. SHE OPENED THAT IN 1963. IN THE '70S AND '80S, THE SCHOOL OFFERED ASSOCIATES, BACHELOR'S AND MASTER'S DEGREES IN INSTRUMENTS, VOICE PERFORMANCE, THEORY, COMPOSITION AND MUSIC HISTORY. BEFORE HER DEATH, SHE WAS RUNNING THE SCHOOL AND TEACHING PIANO FROM HER HOME. AND SHE IS SURVIVED BY HER BELOVED SISTER AND HER HUSBAND, JONATHAN, AND JOSEPH EUBANKS, HER BROTHERS. ALSO, I JUST WANTED TO SAY A LITTLE BIT MORE ABOUT FLOYD PATTERSON. HE WON THE OLYMPIC GOLD MEDAL IN THE 165-POUND DIVISION AT THE 1952 HELSINKI GAMES, AND IN 1956, AT 21, WON THE VACANT HEAVYWEIGHT TITLE AND AGAIN IN 1960. HE PASSED AWAY MAY 11TH AT THE AGE OF 71. 

SUP. KNABE: MR. CHAIRMAN, I HAD ONE OTHER ADDITIONAL ADJOURNMENT. WE'LL GET THE INFORMATION TO THE EXECUTIVE OFFICE, BUT I WANTED TO ADJOURN IN THE MEMORY OF AMY SOTO, WHO IS A RESIDENT OF THE PALOS VERDES PENINSULA AND SURVIVED BY HER HUSBAND HOWARD AND HER BROTHER, HERB HATANAKA, WHO IS ONE OF MY COMMISSIONERS. 

SUP. YAROSLAVSKY: ALL RIGHT. WITHOUT OBJECTION, THAT'LL BE THE ORDER. DO WE HAVE ANY OTHER ITEMS BEFORE US? 

SUP. BURKE: I HAVE AN ITEM, AND I THOUGHT I HAD ALREADY PUT IT INTO THE RECORD BEFORE, OR INTRODUCED A MOTION, BUT IT RELATES TO THE MEDICAL HUBS, AND SO I WILL GIVE IT TO YOU, AN UPDATE IN TERMS OF THE MEDICAL HUBS AND THE PASSPORT. BUT IN CASE I DIDN'T HAVE THAT INTRODUCED BEFORE, BUT I THINK I ALREADY PUT IT IN. 

SUP. YAROSLAVSKY: YES WE DID. ALL RIGHT. WE HAVE A PUBLIC COMMENT. IS THAT -- THAT'S ALL WE HAVE LEFT? 

SUP. BURKE: WE'LL PUT IT IN AGAIN JUST TO BE SURE. 

SUP. YAROSLAVSKY: ALL RIGHT. IS GARY BARNETT, MICHAEL BAUER, I'M GOING TO CALL YOU ALL TO COME DOWN AT THE SAME TIME, PATRICIA -- 

PATRICIA MULCAHEY: MULCAHEY. 

SUP. YAROSLAVSKY: MULCAHEY, AND HAROLD RAY. ARE THEY HERE? COME ON DOWN. GARY BARNETT HERE? MICHAEL BAUER? ALL RIGHT. GO AHEAD, MS. MULCAHEY. 

PATRICIA MULCAHEY: HELLO, MR. ANTONOVICH AND BOARD OF SUPERVISORS. MY CASE NUMBER IS CK27442. FIRST OF ALL, I'M ONE OF THE PARENTS THAT OPPOSED THE K.D.I. SETTLEMENT FOR NOT ENOUGH NOTICE WAS GIVEN TO THE FAMILIES. I WANT TO ASK THE BOARD OF SUPERVISORS AND THE D.C.F.S. AND THE SOCIAL WORKERS WHY IS IT, I WANT YOU TO ADDRESS THIS, WHY IS IT THAT THE D.C.F.S. AND THE SOCIAL WORKERS CAN PUT DOWN FALSE STATEMENTS AND COMMIT PERJURY TO THE COURT OF LAW? AND I WANT TO KNOW WHY THERE'S NO PUNISHMENT FOR SOCIAL WORKERS WHO COVER UP THE ABUSE OF CHILDREN IN THE FOSTER CARE SYSTEM. EXAMPLE, MY SON THAT SUFFERED FROM AUTISM BECAME SO MALNOURISHED IN THE CARE OF THE D.C.F.S., AND THEY COVERED IT UP, THAT MY HUSBAND DOCUMENTED IT. I HAD TO PULL THE PICTURE UP AND I TOOK IT TO A PERSON BY THE NAME OF STEVE COOLEY, WHICH IS A DISTRICT ATTORNEY. HIS SECRETARY SAID AND STATED THAT THE ABUSE OF MY CHILD WAS CHILD ABUSE. THE SECRETARY, WHICH WAS A FEMALE, TOLD ME TO GO TO LANCASTER AND HAVE THEM DO A COURTESY REPORT AND THAT'S THE ONLY REASON MY AUTISTIC CHILD WAS REMOVED FROM THAT HOUSEHOLD. THE SOCIAL WORKERS TOLD ME THAT THEY RAN CRIMINAL BACKGROUND CHECKS ON EVERYONE THAT LIVED AT BEVERLY BANKS' HOUSE, WHICH IS FALSE. I HAD TO GO TO THE CRIMINAL COURT AND I RAN BACKGROUND CHECKS ON ROOSEVELT BANKS, WHICH WAS HER GRANDSON, ROOSEVELT BANKS JR., HE HAD A CRIMINAL RECORD. ROOSEVELT BANKS, SR. HAD A CRIMINAL RECORD AND THESE PEOPLE COULD ALSO WATCH MY CHILDREN. MY DAUGHTER, RAVEN, WAS SEXUALLY ABUSED IN THE CARE OF THE D.C.F.S. FROM THE AGE OF 10 TO THE AGE OF 12. I WANT TO KNOW WHY THERE'S NO PUNISHMENT FOR SOCIAL WORKERS THAT KEEPS THIS HIDDEN. I WILL ASK YOU FOR SOMEONE TO ADDRESS THIS. 

SUP. YAROSLAVSKY: OKAY. 

PATRICIA MULCAHEY: BECAUSE MY DAUGHTER AND MY CHILDREN WERE NEVER ABUSED IN OUR CARE. YOU KNOW, I HAD THE SOCIAL WORKERS TAKE AWAY MY KIDS AND SO LATER ON I FOUND OUT THAT THEY COMMITTED PERJURY. 

SUP. YAROSLAVSKY: ARE YOU FINISHED? 

PATRICIA MULCAHEY: YES. COULD YOU ADDRESS THIS? 

SUP. YAROSLAVSKY: WE WILL NOT ADDRESS IT HERE, BUT WE WILL CERTAINLY TRY TO GET YOU AN ANSWER, AND IF SOMEBODY FROM D.C.F.S. IS STILL HERE? IF NOT, MY STAFF WILL -- 

PATRICIA MULCAHEY: DO YOU KNOW WHAT IT'S LIKE -- 

SUP. YAROSLAVSKY: MA'AM, MA'AM? 

PATRICIA MULCAHEY: TO HAVE -- IT RIPS MY HEART APART, BECAUSE I CANNOT PROTECT MY CHILD FROM THE ABUSE IN YOUR CARE. 

SUP. YAROSLAVSKY: OKAY. THANK YOU. MR. -- WE'RE GOING TO TRY TO HAVE SOMEONE TALK TO YOU. HAROLD RAY. 

HAROLD RAY: HAROLD RAY, YES. 

SUP. YAROSLAVSKY: YOU'RE ON. 

HAROLD RAY: I NOTICED IN THE PAPER THAT YOU HAD A DEALING WITH THE AGENCY, D.C.F.S., IN THE SECOND PARAGRAPH DOWN ON THAT PAPER, IT SPEAKS ABOUT US BEING AN INDEPENDENT REVIEW BOARD FOR THE BAD OFFICERS FOR SHERIFF BACA. WE ARE A BONDED LICENSE RECOVERY, WE ARE FEDERAL INCORPORATED, AND I'M HERE FOR D.C.F.S., TOO, BECAUSE THE PAPERWORK THAT I GIVE YOU NOW SHOWS THAT THE NINTH DISTRICT COURT SAYS THAT YOU'RE NOT ALLOWED TO GO INTO A HOME WITHOUT A SEARCH WARRANT AND TAKE THE CHILDREN OUT. ALSO, FURTHER IN THERE IT SHOWS THAT THEY CAN BE TAKEN TO COURT INDIVIDUALLY BY THE PERSON THAT HAS THEIR KIDS TAKEN AWAY FROM THEM AND FILED CHARGES AGAINST THEM FOR KIDNAPPING IN THE COURT ITSELF, AND THEY CAN WIN ON IT. I'VE HAD IT DONE UP IN REDDING, I'VE HAD IT DONE SEVERAL TIMES DOWN HERE. WE REALLY NEED -- YOU REALLY NEED TO TAKE CARE OF THIS SITUATION, BECAUSE IT IS GETTING WORSE, AND NOW YOU COME BACK AND YOU'RE GOING TO DO SOMETHING ABOUT WHAT HAPPENED THREE YEARS AGO, BUT, YOU KNOW, YOU DIDN'T DO ANYTHING ABOUT IT THREE YEARS AGO. YOU SHUT DOWN THE BUSINESS, THAT'S TRUE, BUT WHAT ABOUT THE KIDS THAT ARE IN CRACK HOUSES, WHAT ABOUT THE KIDS THAT ARE BEING MOLESTED IN THOSE CRACK HOUSES? YOU'RE NOT DOING ANYTHING ABOUT THAT. SO ANYHOW, WHAT WE'RE GOING TO DO, WE'RE GOING TO TURN AROUND AND GIVE YOU 30 DAYS TO START CLEANING THIS UP. IF IT DOESN'T GET CLEANED UP, START CLEANING UP IN 30 DAYS, WE'RE GOING TO START VISITING ALL THE COURTS, TALK TO THE PEOPLE, FIND OUT WHICH ONES HAVE HAD THE PROBLEM DEALING WITH THAT DIDN'T HAVE A COURT ORDER TO TAKE THOSE KIDS OUT OF THE HOME. THAT'S BREAKING THE CONSTITUTION. AND THE PRESIDENT SAID IF YOU DON'T FOLLOW THE CONSTITUTION YOU CAN BE FIRED. HE ALSO SAID IF YOU CAN'T INTERPRET -- YOU CAN ONLY INTERPRET THE LAW, YOU CANNOT MAKE A LAW, SO THESE LAWS THAT HAVE BEEN PUT IN BY CHILDREN'S SERVICES, AND WHAT THEY'RE DOING, IN FACT, ONE OF THEM, I HAD TO CALL -- THEY PUT ME UP TO SACRAMENTO WITH A REPRESENTATIVE UP THERE, AND HE SAID THAT THAT LAW WASN'T IN EFFECT, IT HAD NEVER BEEN RATIFIED. SO WHAT ARE THEY DOING? THEY'RE USING LAWS THAT THEY DON'T EVEN UPHOLD, THEY'RE NOT A LEGAL LAW, SO THIS IS WHAT WE'RE GOING TO DO, WE'RE GOING TO TURN AROUND AND WE'RE GOING TO SEE WHAT YOU'RE GOING TO DO ABOUT IT IN THE NEXT 30 DAYS. AFTER THAT, WE START GOING INTO THE COURTS AND WE'RE GOING TO GET SOME JUDGES FIRED, IF WE HAVE TO, AND WHOEVER DOESN'T FOLLOW UP ON THIS AND TAKE CARE OF IT, IT CAN BE HAPPENED TO, BECAUSE THIS IS FROM THE PRESIDENT, NOT FROM US, IT'S FROM THE PRESIDENT. IF YOU DON'T FOLLOW THE CONSTITUTION, YOU CAN BE FIRED. SO NOW IT'S UP TO YOU WHAT YOU WANT TO DO. YOU CAN EITHER FOLLOW THE CONSTITUTION OR YOU CAN THROW IT AWAY. YOU THROW IT AWAY, THEN THE JUSTICE DEPARTMENT WILL COME IN AND THEN THEY'LL TAKE OVER. THANK YOU VERY MUCH. 

SUP. YAROSLAVSKY: THANK YOU, MR. RAY. THERE'S NO OTHER -- NOBODY ELSE WHO WANTS TO BE HEARD ON PUBLIC COMMENT. WE WILL RECESS INTO CLOSED SESSION. 

CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION AS INDICATED ON THE POSTED AGENDA. 

SUP. BURKE: I'LL PUT IN THE MOTION IN CASE IT HAS NOT GONE IN BEFORE, AND THEN YOU CAN CHECK TO SEE IF IT'S A DUPLICATE. 

CLERK SACHI HAMAI: IT HAS NOT, BUT IF YOU WANT TO -- 

SUP. BURKE: OKAY, ALL RIGHT. I'LL PUT IT IN. AND BASICALLY IT'S ON THE MEDICAL HUBS AND ALSO TO FOLLOW-UP A REPORT BACK ON THE MEDICAL HUBS AND THE PASSPORT. MEDICAL PASSPORT. YES. 

SUP. YAROSLAVSKY: ALL RIGHT. [ GAVEL ] 

SUP. BURKE: IT'S REALLY A REPORT BACK. I THINK IT WAS RIGHT NOW I GUESS, IT'S A REPORT BACK, REALLY. BASICALLY WHAT I'M TRYING TO DO IS TO GET AN UPDATE ON THE MEDICAL HUBS AND FOR THE CHILDREN IN D.C.F.S. AND ALSO TO FIND OUT THE STATUS OF THE PASSPORTS, THE MEDICAL PASSPORTS THAT WE HAD APPROVED SOME TIME AGO, AND WOULD JUST LIKE TO HAVE A REPORT BACK FROM D.C.F.S. ON THE STATUS OF IT 

SUP. YAROSLAVSKY: IS THERE A TIME THAT YOU'RE REPORTING ON? 

SUP. BURKE: 30 DAYS. 

SUP. YAROSLAVSKY: 30 DAYS. OKAY. THERE'S A REPORT BACK, THERE'S NO NEED TO POST IT SO WE -- 

SUP. BURKE: I THINK I ALREADY SUBMITTED IT. 

SUP. YAROSLAVSKY: ALL RIGHT, DO YOU WANT TO JUST GO AHEAD AND APPROVE IT? 

SUP. BURKE: I'LL GO AND -- YES. 

SUP. YAROSLAVSKY: ALL RIGHT, BURKE MOVES, KNABE SECONDS, WITHOUT OBJECTION, NEEDS TO BE A REPORT BACK IN 30 DAYS. ALL RIGHT? LET'S GO INTO EXECUTIVE SESSION THEN. 
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